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Welcome
Welcome to iView MediaPro, the fast and easy 
way to view, organize and present the growing 
number of images, movies, sounds, fonts and 
other media fi les on your disks.

MediaPro helps you get organized. Whether you 
are a student, journalist, amateur photographer or 
multimedia professional, it’s important to organize 
and browse your images, movies and documents  
in an application that’s easy to set up and use.

MediaPro works by creating catalogs, consisting 
of thumbnails and descriptions of all your media 
fi les. Store your images with digital camera infor-
mation, captions, labels and annotations  —  then 
search and browse the catalog, even if your original 
fi les are misplaced or off-line. You can edit images, 
correct colors, print contact sheets and change fi le 
formats — even create a slide show of your favorite 
images and save it as a QuickTime movie.

MediaPro uses Apple’s QuickTime, the acclaimed 
playback system for digital media. Using QuickTime 
ensures the highest quality and easy integration 
with your existing software and operating system.

Installation 
Copy the iView MediaPro folder from the CD to 
the Applications folder of your hard disk. If you 
have an existing copy of MediaPro, remove it from 
your Applications folder or rename it so that it isn’t 
replaced when installing the new version.

New in 2.0: In previous versions, there was a 
Plug-ins folder inside the MediaPro folder. This 
folder has now been split between built-in plug-
ins, which are located inside the application pack-
age, and user-installed plug-ins, which go in:

OS 9: System Folder/Application Support/
iView/Plug-ins

OS X: Any of the three locations
• ~User/Library/Application Support/iView/
Plug-ins

• /Library/Application Support/iView/Plug-ins

Installing & Setting up iView MediaPro

• Network/Library/Application Support/iView/
Plug-ins
When installing custom HTML templates, print 

templates, favorites lists, AppleScripts or import-
ers, place them inside the user-defi ned plug-ins 
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Installation 

Step 1: Copy folder from the CD-ROM to the hard disk. 

Step 2: Launch application. Go to the License menu and 
select Enter License.

Step 3: Enter the license number from the cover of the 
CD-ROM. If you purchased a digital download version of 
iView MediaPro online, then enter the license number 
that was emailed to you.
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folder, and not the application package. This 
way, you’ll never lose your custom settings when 
upgrading to future versions of MediaPro.

Entering your license key 
After you have installed iView MediaPro, launch 
the application. Go to the License menu and enter 
your name, organization and the license number 
from the cover of the CD-ROM or the license num-
ber that was emailed to you. If you have lost your 
license key, please contact support at: 
http://www.iview-multimedia.com/support

System requirements 
This section lists the minimum and recommended 
system requirements in parentheses.

• PowerPC or newer, such as iMac G3, G4.
• Mac OS 9.1.x or Mac OS X (10.1.x)
MediaPro no longer supports OS 8.x.

• CarbonLib 1.5 (1.6)
• QuickTime 5.1+ (6.x) 
• 8 MB of RAM (OS 9): Since QuickTime handles 
many of MediaPro’s tasks,  allocating more 
memory will not make the application run 
faster because it will take away available 
memory for QuickTime.

• Monitor set to Thousands or Millions
• 3 MB of hard disk space for installation

Language support
MediaPro can be viewed in: English (US),  French, 
German, and Japanese. By default, MediaPro uses 
the language of the operating system or remem-
bers the last language used. 

Adding Media Importers 
Any QuickTime-based media importer can be 
used by MediaPro. Download the importer and 
place it inside your System Extensions folder, or the 
user-defi ned MediaPro Plug-ins - Importers folder 
(see Page 2). Additional importers can be down-
loaded from 3rd-party sources on the Internet.

Examples of importers
• PDF and EPS: To catalog PDF on OS 9 and 

render EPS fi les (OS 9 and X), download the 
GNU Ghostscript system extension. 
www.iview-multimedia.com/products/
additionaldownloads.html

• NEF: To render Nikon Raw Files you need 
NikonView 4 or newer installed in your system.

AppleScript 
MediaPro is scriptable and can be easily integrated 
with 3rd-party applications or database systems 
to perform workfl ow automation. To get started 
with scripting MediaPro, look at the application’s 
dictionary, and refer to the AppleScript examples 
included (see Documentation folder).

Version 2.0 has added a number of changes to 
the AppleScript dictionary. Please make sure and 
test your exisiting scripts to ensure proper func-
tionality before using them.

Using web resources
You can access additional resources for learning 
iView MediaPro on the iView web site. Tutorials, 
customer support, forums and application updates 
are available at:

• Select the AppleScript menu, and choose 
iView Online from the Web submenu. 

• Or type this URL into your web browser:
www.iview-multimedia.com

In
stallation

OS X: To change 
languages, select 
the MediaPro icon 
and click CMD-I 
(Get File Info). 
Choose Languages 
in the drop-down 
menu. MediaPro 
will default to the 
operating system 
language. If you 
want MediaPro to 
run in a different 
language, click 
off all languages 
except the one you 
want. 
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iView MediaPro 2.0 extends its robust, award-
winning functionality with enhanced workfl ows, 
fi le system control and powerful image editing 
tools. Version 2.0 increases capacity to 128,000 
media items per catalog, while maintaining its 
unparalleled speed, feature set, elegance and 
ease of use.

Explore the new features of iVIew MediaPro:

iView Catalog Reader
iView Catalog Reader is a royalty-free, cross-plat-
form software that permits unrestricted sharing 
of iView catalogs and Slide Shows. With Reader, 
you can create small, portable catalogs to share 
with clients, colleagues, friends and families who 
do not own an iView program. (Page 60)

Information Management
Drag-and-drop Organizer: This new panel allows 
instant searching, annotating and classifying with 
unlimited criteria across large volumes of media 
fi les. It contains the Field Finder and Catalog Sets.  
The Field Finder is used to locate media in the 
catalog. (Page 32)

Field Finder: This can be used to add annota-
tions to media using drag-and-drop. Simply drag-
and-drop your media over the existing annota-
tions and you have assigned them to the dragged 
media items. This greatly speeds up and simplifi es 
the process.

Extended IPTC annotation support: Now 
includes the IPTC fi elds Event (Fixture), Location, 
Status and People.

Instant catalog-wide searching: Search cata-
logs quickly and directly from the new search box. 
Searching is case-insensitive and includes all EXIF, 
IPTC and media fi elds. (Page 42)

Catalog Finder: Quickly locate and preview all 
iView catalogs on a storage volume.  (Page 6)

ColorSync Management
The new Manage Color Profi le dialog allows you 

What’s new in MediaPro 2.0

to embed RGB and CMYK ColorSync Profi les 
for individual fi les, or a batch of fi les. It displays 
the ColorSync image immediately as a preview, 
allowing to you commit or abandon this selection. 
MediaPro 2.0 also extends ColorSync support to 
the Thumbnail view. (Page 29)

Slide Shows
Individual confi guration: The Slide Show in 
MediaPro 2.0 has been improved to allow speci-
fi cation of timing, media scaling, transition effect 
and grid display for each individual media item. 
This allows you to defi ne all possible display and 
timing parameters. The Slide Show can display 
any supported media item, including audio which 
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Search Box: Type the word or words in this fi eld and 
press the Return or Enter key. Results are presented in 
the active catalog view. 

Image Enhancement Tools: Improved cropping tools 
and red-eye reduction.

Drag-and-drop annotating: To add annotations, drag-
and-drop to the Organize Panels’ Field Finder.
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allows you to add soundtracks to a Slide Show.
Save Slide Show as Movie: The process of 

exporting your Slide Show as a QuickTime movie 
has been simplifi ed. The exported movie created 
will match the current settings of the Slide Show,  
including timing, transition, scaling and grid 
settings. The QuickTime fi le size produced by 
creating a movie has been signifi cantly reduced.  
(Page 49)

Image Enhancement Tools
iView MediaPro now offers powerful yet precise 
image editing as well as calibration tools that can 
enhance the color, sharpness and brightness of 
your images. New tools include: 

• Improved cropping
• One-click enhancements to compensate for 
under/over exposure, low contrast, backlight-
ing and more

• Red-eye reduction
• Precision rotation
Each tool supports version control and batch 

application.  (Page 64)

File & Folder Management
MediaPro introduces advanced fi le and folder 
management to enhance workfl ows and provide 
direct control over your fi le system. (Page 39)

Folder Watching: Catalog-wide folder watch-
ing can be enabled to constantly monitor folders 
which contain media within your catalog. When 
new media items are added to any of these 
folders MediaPro alerts you to the new content. 
(Shown by a blue arrow on the folder icon.) You 
can then choose to import these new fi les directly 
to your catalog from your stored media location.

Auto-Importing takes folder watching to the 
next level by automatically importing from select-
ed folders when media are added.  (Page 39)

Direct File Manipulation: Undertake system 
fi le operations directly:

• Remove fi les and folders from the catalog and 
physical storage. 

• Reveal fi les and folders in the Finder.

• Create and rename folders.
• Move fi les directly around the fi le system 
from within the catalog.

HTML Custom Themes
MediaPro 2.0 improves the HTML export by intro-
ducing custom themes. Each theme is presented 
as a menu option, displayed as a preview.

Through the plug-in architecture of MediaPro 
additional themes (completely customized to 
your requirements) can easily be added to your 
existing portfolio. This fl exible approach gives 
MediaPro users a powerful and unique solution 
for creating web content. (Page 51)

PDF Maker
This new feature allows you to produce high-
resolution PDF fi les of any size and layout using 
the media in your catalog. It can be completely 
customized. (Page 77)

Performance improvements
Reduced size of catalogs: By using JPEG com-
pression for the display of media items in the 
Thumbnail view (only) iView catalogs are now 
even smaller. This does not prevent iView Media 
or iView MediaPro 1.5 from opening catalogs 
written by MediaPro 2.0.

Increased JPEG Rotate performance: The per-
formance of the JPEG Rotate function has been 
improved by a order of magnitude.

Other Features
MediaPro 2.0 additionally includes the following 
new features:

• Long fi le name support.
• Increased capacity to 128,000 media items 
per catalog.

• Merge catalogs (Page 8) 
• Improved layout management using the View 
Options palette (CMD-J).

• New File Format support: MultiAd Creator and 
Kodak DCSPro4SLR.

• New Playlist feature, in any view.

N
ew
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 2.0
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How iView MediaPro works
iView MediaPro stores information about your 
media fi les in catalogs. A catalog is a searchable 
and organizable visual database that contains: 

• A thumbnail of each media fi le.
• Media information about each fi le relevant to 
the media type.

• Tags and descriptions (called annotations) 
that help you organize media.

• The location of the original fi le on hard disk, 
CD-ROM, or other volumes.
You can create as many catalogs as you want, it 

just depends on how you want to organize your 
media. For example, you can have a catalog for 
each media type: photos, videos and music. Or 
you could create one catalog of all media. Each 
catalog can contain up to 128,000 fi les.

Understanding catalogs
When you add media fi les to a catalog, the appli-
cation stores a thumbnail of each fi le, as well as 
information about the fi le and its location on 
your disk. 

This way you can launch and search iView 
Media catalogs, even when your original fi les are 
not present. For example, they may be stored on a 
CD-ROM that is not in the computer. But you can 
still view thumbnails of those fi les and informa-
tion about the media. 

Because media fi les are not embedded into the 
catalog, iView MediaPro will need access to media 
fi les in order to display them in larger scale, such 
as Media View and Slide Shows.

If you delete a media fi le on the desktop or a 
disk, it cannot be recovered through a MediaPro 
catalog. The catalog only contains information 
about the fi le.

Adding fi les to an iView MediaPro catalog does 
not move or modify the original media.

Create a catalog 
Step 1: Launch application 
Double-click the iView MediaPro icon to open the 
application. 
Step 2: Add media fi les 
Drag-and-drop: Drag any fi le, folder, hard disk, CD, or 
other volume into the MediaPro window. You can 
also drop fi les onto the MediaPro icon or shortcut 
icon. In either case, your media fi les appear in an 
MediaPro catalog.
File menu: In this menu, select Import Media from 
Files and Folders. This will bring up a dialog box 
where you navigate to and chose a folder or fi le 
to import into your catalog.
Step 3: Begin to view and organize your media.

Finding catalogs
New in 2.0: The Catalog Finder allows you to 
quickly locate and preview all iView catalogs on 
a storage volume (hard drive, CD, DVD, etc.) The 
Catalog Finder is located in the Open Recent sub-
menu of the File menu (Shift+CMD+O). Select a 
storage volume from the pull-down menu, then 
click Find. Click on a catalog name in the search 
results list to preview the found catalog. Click 
Open to launch the catalog.

iView MediaPro Basics
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Catalog Icon 
on the Desktop

Catalog Finder:  Locate and preview catalogs. 
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Capture Date. This way your media will be bet-
ter organized on the desktop as well. You can 
also instruct MediaPro to embed a ColorSync 
Profi le during import. Clicking the folder icon 
allows you to designate a folder on the desk-
top for downloading.

5. The Annotations panel allows you to set a few 
annotations (author, credit, source, copyright) 
to apply to every image during import.

6. Once options have been set, click the Download 
button. MediaPro will import each image into 
the open catalog after it has been downloaded. 
After import is complete, eject the camera disk 
icon and safely unplug your camera.

Add fi les from a digital camera 
Mac OS X only
The Image Capture application is a part of the 
OS X operating system that allows Macintosh 
users to automatically download images once a 
camera is attached to the computer. MediaPro has 
integrated this functionality to make cataloging 
images during download from your camera as 
easy as possible.
1. Launch the Image Capture applica-

tion. It is located in the OS X Appli-
cations folder. 

2. OS 10.1.x - In the Hot-Plug Action pull-down 
menu, select Other. You will be prompted to 
identify an application. Find and select your 
copy of iView MediaPro, then quit the Image 
Capture application. OS 10.2.x - Open the 
Image Capture Preferences. Choose Other in 
Camera Preferences pull-down menu. Navi-
gate to and choose iView MediaPro. Quit the 
Image Capture application.

3. Plug your camera into your computer. From 
this point, whenever you plug a camera into 
your computer, Image Capture will launch 
MediaPro. To import images, select Import 
Items From Camera in the File menu (CMD-M). 
If iView Media is already launched when you 
plug in your camera, the Import From Camera 
dialog box will automatically appear. 

4. In the Import From Camera dialog, you can 
instruct MediaPro to delete images off your 
camera after downloading. MediaPro can also 
set the image fi le’s creation date to match 
the date you took the picture (Capture Date). 
This is useful because some applications, as 
well as the operating system, cannot read the 

M
ed
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OS X: Image Capture preferences dialog in 10.2.x

Import from Camera - Options: By clicking the Folder icon, 
you can choose a folder on the desktop for downloading.

Import from Camera - Annotations: Any data entered here, 
will be applied to all images during import.
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Add fi les to a catalog 
Drag-and-drop an individual fi le or a folder that 
contains new fi les onto an open catalog, or use 
the File menu’s Import Media from Files and Folders 
option. MediaPro will go through these fi les and 
add only the new fi les to the catalog. 

You can also add fi les through MediaPro’s 
Folder Watching feature. For more information on 
this feature, see page 39.

Merge catalogs 
New in 2.0: iView MediaPro 2.0 offers a new way 
to combine the contents of a catalog with other 
catalogs.  Merge With Catalog appends a selected 
catalog to the currently open catalog. 

How to merge catalogs
1. Open an existing catalog.
2. Select Merge With Catalog under Import Items 

in the File menu. 
3. Navigate to and select an existing catalog 

created by an iView product (includes previ-
ous versions of MediaPro, or iView Media or 
MediaLE).  This function will not work with 
catalogs created by other programs.

4. Files will be added to the bottom of the 
existing catalog. Each item’s related annota-
tions, label and thumbnail are added as well. 
Catalog Sets are not merged into the open 
catalog.
If the item’s thumbnail in the existing catalog 

is smaller than the catalog being appended, then 
the thumbnail will have to be rebuilt to match the 
new size. For example, an existing catalog might 
have 128 pixels thumbnails. If the catalog it is 
being merged with has 160 pixel thumbnails, then 
the previous thumbnails will appear smaller.

To fi x this, select the appended fi les and choose 
Rebuild Thumbnails in the Action menu.

Note: If the open catalog already contains fi les 
that are part of the catalog that is being imported, 
MediaPro will ignore these fi les and will not rep-
licate them.

Add fi les from another catalog using drag-
and-drop:  An alternative way to add items from 
one catalog to another is using the drag-and-
drop method. 

To do this, open two catalogs. Select a fi le, or 
group of fi les, and drag them from one catalog 
to the other. Unlike Merge With Catalog, where 
fi les are appended to the bottom of the catalog, 
dropped fi les are added to the specifi c position 
in the catalog defi ned by your cursor placement 
(applies to List and Thumbnail Views). If you drag-
and-drop items into a catalog that is currently in 
Media View, then the dropped items will appear 
at the end of the catalog.

Using drag-and-drop does not remove a fi le 
from a catalog and add it to another. This function 
copies a media item’s reference from one catalog 
to another. As such, each item’s related annota-
tions, label and thumbnail are added. 

If the item’s thumbnail in the existing catalog 
is smaller than the catalog being appended, then 
the thumbnail will have to be rebuilt to match the 
new size. For example, an existing catalog might 
have 128 pixels thumbnails. If the catalog it is 
being merged with has 160 pixel thumbnails, then 
the previous thumbnails will appear smaller.

To fi x this, select the appended fi les and choose 
Rebuild Thumbnails in the Action menu.

If the open catalog already contains fi les that 
are part of the selection of fi les that are being 
dragged-and-dropped, MediaPro will ignore 
these fi les and will not replicate them.
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Add fi les through drag-and-drop: Files are added to a 
catalog in the exact position of the cursor highlight, the 
long bar that is separating the two items above.
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Import options 
Import options control what media fi les are 
added to a catalog. You can control the import 
process by choosing Import Options in the Edit 
menu (Shift-CMD-I). 

The options are divided into two panels: File 
fi lters and Media Types.

File fi lters: Limit the range of imported media 
based on fi le-related criteria, such as fi le name, 
fi le size, creation or modifi cation date, etc. For 
example, to only import fi les smaller than 1 MB, 
choose to enable the size option as:  “size is less 
than 1000 KB.”

Ignore aliases: Checking this box will tell 
MediaPro to bypass alias fi les. Left unchecked, 
the application will fi nd the original location of 
the aliased fi le and catalog it.  

Ignore invisible fi les: Checking this box will pre-
vent MediaPro from cataloging invisible operat-
ing system fi les, such as .DS_Store.  

New in version 2.0: The option for using built-
in thumbnails has now moved to the MediaPro 
Preferences dialog, Media-Images panel.

Media Types: Limit importing to just those 
fi les that belong to a certain media group. For 
example, you may turn on the Images option 
only in order to import images such as JPEG, 
pictures, etc.

If you are not familiar with what types of media 
fi les belong to each group you may click the View 
Media Types button, for a comprehensive list of all 
media types supported by iView MediaPro. 

Supported fi le formats
iView MediaPro can catalog a large number of 
image, movie and sound fi le types.  MediaPro’s 
capacity to import certain fi le types in dependent 
on having the most current version of QuickTime 
installed in your computer. 

See the Media Importers dialog to fi nd out which 
version you have installed. For a list of supported 
fi le formats, see page 81.

Import Options: Filters panel

Import Options: Media Types panel

Media Importers can be found on the Media Types 
panel of the Import Options dialog box, or use the 
keyboard shortcut, Shift-CMD-I. 
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iView MediaPro Preferences
Additional setup options can be defi ned in the 
Preferences dialog box by choosing Preferences 
under the iView MediaPro menu or use the key-
board shortcut, CMD-Comma ( , ).

General
Options: Display a useful description under the tool-
bar buttons; Sort media based on natural order (i.e. 
8, 9, 10, 11...); and have a confi rmation dialog appear 
when batching items or when removing items from 
a catalog or set.
At Startup: Select whether you want to open 
a new catalog, open last catalog or do nothing 
every time you launch the application.
Double-Click: Select how MediaPro interprets 
double-clicking. Option double-click will always 
launch the selected media fi le with the creator 
application.
Dimensions: Change the default unit from pixel 
to centimeters, inches, points and picas.
Resolution: Change the default resolution from 
Pixels/Inch to Pixels/cm.
Date: Change the display in various date fi elds. 
New in 2.0: iView MediaPro catalogs now sup-
port long fi le names. In previous versions, long 
fi le names were truncated.

Scratch
The scratch folder keeps temporary versions of 
your open catalogs. Scratch fi les are erased when 
you close or save your catalogs. Choose a fast 
local disk with plenty of available space. 

Media - Images
Use built-in thumbnails: Some applications, such 
as Photoshop, embed a thumbnail into the media 
fi le. Digital cameras do this as well. These thumb-
nails are typically low quality. During import, 
iView MediaPro uses that embedded thumbnail 
if the box is checked. Keeping this option turned 
off ensures that MediaPro creates its own thumb-
nails, which are generally higher quality but slows 
down the import process. If you wish to improve 

the quality of the thumbnails later, choose Rebuild 
Thumbnail in the Action menu.
Rendering: Allows you to place a limit on the 
size of images that the application will display in 
Media View and Slide Show mode. If an image is 
over the limit defi ned, MediaPro will not render it. 
This option will accelerate importing large images 
when viewed in Media View. Available range: 1 to 
100 megabytes.
Transparency: Choose the background color 
used for transparent spaces in various image fi le 
types, such as GIF and Adobe Photoshop.
Matching: If an image has an embedded profi le 
MediaPro uses it to match it to the profi le of your 
monitor. Otherwise, MediaPro uses default docu-
ment profi les chosen in the system’s ColorSync 
control panel.

Preferences: General panel

Preferences: Media - Images panel
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Media - Fonts
Media View: Fonts can be displayed as a standard 
character set, full character set, or as sample text 
that you defi ne. The Font Size option only applies 
to True Type fonts. Bitmap fonts are displayed at 
the size defi ned within the font.  These options 
also apply to the disply of fonts in Slide Shows.

Thumbnail View: Thumbnails of fonts can be 
displayed as the font name or as two characters  
of sample text that you defi ne.  If you change this 
option after importing fonts into a catalog, you 
will select all thumbnails, and choose Rebuild 
Thumbnail in the Action menu in order to have 
iView MediaPro recreate the font thumbnail with 
the new option. 

Media - Kodak
Photo CD: Photo CDs offer a variety of fi le sizes. 
This option tells MediaPro which size to catalog: 
Small, Normal and Large options.
Digital Camera RAW (DCR): The Look (Profi le) pop-
up menu adjusts the color tone of DCR images 
when rendered by MediaPro.
Rendering: Newer DCR images contain a large 
preview that is suitable for viewing and renders 
much faster than decoding the raw data. If you 
check Use embedded preview, this will speed up 
import and media rendering of DCR fi les.

Preferences: Media - Fonts panel shown.

Preferences: Media - Kodak formats panel shown.

Sample text font displayed in Thumbnail View.

Font name display in Thumbnail View.

Font full character set displayed in Media View.

Font character set displayed in Media View.

M
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Catalog information 
The Catalog Info dialog (File menu, CMD-K) con-
tains information about your catalog, as well as 
giving you a place to make comments about the 
catalog. The Comments fi eld can be exported with 
HTML web galleries.

Protecting catalogs 
Once you have created a catalog, you might want 
to prevent others from viewing or accessing it. To 
set password protection for a catalog:
1.  Select Catalog Info from the File menu.
2.  Click on the Set Password button. This button is 

only available if you have saved your catalog.
3.  Type the password. Then save the catalog. 
4.  When opening the catalog in the future, you 

will be asked to provide the password before 
you can view the catalog’s contents. There is 
no way to recover a catalog password, so make 
sure to keep your passwords in a safe place. 

5.  To remove password protection, click on the 
Set Password button and delete the password 
in the fi eld. Then save your catalog, and pass-
word protection will be removed. 
Password protection on iView catalogs is not a 

high-level of encryption. For higher levels of secu-
rity, consider making an encrypted disk image 
using Apple’s Disk Copy or a tool like PGP.

Other options for protecting catalogs
Set fi le lock properties: In the Finder, choose 

your catalog and select Get Info in the File menu 
(CMD-I). In the dialog, check the box Locked. This 
will prevent the fi le being altered.

While this option doesn’t prevent you or oth-
ers from altering catalogs (all you have to do is 
uncheck the box to unlock the catalog), it can 
serve as a useful reminder to prevent saving over 
a catalog that you do not want changed.

Backup: You can also protect your catalogs and 
media by using MediaPro’s backup feature. See 
page 59 for more information.
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Catalog Info dialog, File menu (CMD-K)

File Info dialog: Check this box to 
Lock a catalog. When turned on, these 
fi les will have a mini-lock icon next to 
the catalog icon.
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About the iView MediaPro workspace

ToolbarView TabsCatalog Name

Header bar
(contextual to view)

Media Viewing Area

Size Menu

Pull corner 
to enlarge

Zoom

Rotate

Catalog Information bar

Toolbar functions

Open With launches the selected media 
items with an application that can view, 
edit or mail media fi les.

Show Media File reveals the location of 
the selected media items on the desktop 
(Finder).

Trash removes one or more fi les from the 
catalog and moves the original to the Trash. 

Assign Label will set one of nine color 
labels to your fi les. Also has option to 
remove labels. 

Info, Organize and Folders 
Panels: Click button to hide/
show panels

Invert 
Order

Show All Items restores the view of a 
catalog to show all items. Available after 
searching, sorting and organizing functions 
show only a subset of fi les in the catalog. 

Drag bar 
adjust width 
of pane.

Drag bar to 
adjust height 
of pane.

Search Box

Voice Annotation allows you to record, 
listen or remove audio annotations 
attached to fi les.

Play Media contains options to play 
an animation, movie, sound (same as 
spacebar). 

Slide Show starts up your presentation 
in a full screen slide show, beginning 
with the selected media fi le.

Rotation sets the viewing angle of a fi le in 
all views, including its thumbnail.  This does 
not change the rotation of the original fi le. 
CMD-[, CMD-].

Zoom increases or reduces the size of 
thumbnails and media in all views. CMD-+, –

Sort will reorder fi les in your catalog by 
24 criteria such as color label, fi le name, 
capture date and dimensions.

Print displays options for printing lists, 
contact sheets and single images from 
your catalog.

Image Editor launches a palette to crop, 
resize photos, as well as adjust color, tone, 
sharpness and make other enhancements.

Show Labelled Items will display 
media fi les marked with a particular 
color label, no label or all labels.
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The MediaPro interface displays information in 
three different views – List, Thumbnail and Media. 
To switch views, click the appropriate tab, or press 
CMD-1, 2 or 3.

All three views offer features that resemble the 
way you work with your fi les in the desktop:

• To fi nd a fi le, type the fi rst letters of its name.
• To change a fi le name, click the name, wait a 
moment, and then start typing.

• To use a contextual menu, Ctrl-Click a media 
fi le’s thumbnail, or anywhere inside the iView 
MediaPro window.

• To rearrange items, drag them to where you 
want them and drop them. You can drag 
single items or groups of items.

• To move or duplicate items to another cata-
log,  drag them from one catalog to the other.

• To move items from the catalog to the desk-
top, drag them to a folder or to the desktop. 
This will move the fi le from its current location 
to the desktop.

• To copy fi les from the catalog to the desktop, 
hold the Option key while dragging them to 
the desktop.

• To move items to another drag-and-drop 
application such as Adobe Photoshop, drag 
them onto the application icon.

• To invert the order of media any catalog view, 
click the invert button (  ) in the upper left 
corner of the media viewing area. 

Viewing fi les in catalogs
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View tabs in Mac OS X. Use CMD-1, 2, and 3 respectively 
to change view.

Hide Tabs & Toolbar: To increase the size of the media viewing area, use Hide/Show Tabs in the Window menu. 

Contextual menu: 
Press Ctrl-Click to 
get quick access to 
many of MediaPro’s 
functions. This menu 
will help you minimize 
cursor movement. The 
contextual menu has 
the same functions in 
all views.
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List View 
In this view of a catalog, media appears in a list 
of small icons with associated information fi elds 
such as fi le name, size, type, duration, etc. To 
change the fi elds displayed, use the View Options 
palette in the Window menu (CMD-J). 

To sort the list according to a fi eld, click the 
corresponding header above the list area. Notice 
that some information is dependent on the fi le 
type. For example, the Duration fi eld applies only 
to movies and sounds. 

To change the size of thumbnails in this view, 
using the Size menu and select Small or Large. 

To rename a fi le, click on its name and start 
typing, the same way as you would do on the 
desktop. iView MediaPro will rename the catalog 
entry and the original fi le only if the item exists 
on the hard drive or on a mounted rewritable 
storage disk. 

By default, the width and height fi elds are in 
pixels. You can change the unit of measure in the 
Dimensions pull-down of the Preferences dialog 
(CMD+Comma). 
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Sort list by criteria: 
Click on the fi eld 
names of the Info Bar 
to sort the list by that 
information.

List View: Click on tab or press CMD-1.

Size menu: Change 
the icons in List View 
to small or large 
(shown left). 

Invert list order

Rename media: Click on the name and start typing, 
the same way you would do on the desktop.

Playback media: Though the icons are small, movies 
and music will play just fi ne in List View. Simply select 
a fi le and press the spacebar. You can also change 
views while the fi le is playing.

Move media: Click on the fi le’s icon, then drag it to 
any location. A line will mark the new placement .

To change fi elds 
displayed, select 
Show View Options in 
the Window menu 
(CMD-J).
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Thumbnail View 
This view displays the catalog as a table of thumb-
nails in adjustable sizes. When you select an item 
in the table, the information bar (text area above 
the thumbnails) presents data about the item. 

Whether the fi le is available or not, the path 
name for the location of the fi le and a media-
related description will appear in the header. When 
a fi le is not available, this information is red. 

To change the position of items in the catalog, 
click one or select a group and drag them to the 
desired location. Or, after you made your selection, 
choose any of the Move Items options in the tool-
bar. If you choose the Move to Location option, you 
will need to click on a destination item, where the 
selected items are going to move to.

 Thumbnail size: To defi ne the display size of 
your thumbnails, choose the size you want from 
the Size menu in the far right side of the Info Bar. 
This setting affects the overall size of your catalog, 
as larger thumbnails require more disk space. 

If an imported image appears much smaller 
than the thumbnail box containing it, MediaPro 

has read an existing thumbnail rather than creat-
ing its own (This is common with Photoshop fi les). 
If you want MediaPro to create its own thumbnails 
every time, make sure Use Built-in Thumbnails is 
unchecked in the Preferences-Media-Images panel 
(CMD-Comma). 

Rotating thumbnails: To rotate a thumbnail 
image, use the Rotate buttons in the far right side 
of the header bar.  Each rotation represents 90 
degrees. You can select multiple fi les and perform 
a batch rotation. Rotating a thumbnail in a catalog 
does not change the rotation of the original fi le. 

The rotation of a thumbnail also applies to how 
MediaPro will display the fi le in Media View, slide 
shows and exported HTML galleries.

Movie Thumbnails: If a thumbnail of an anima-
tion or movie fi le is black or not what you want, 
select the item and play the fi le to a frame you 
like. Then pause the playback and choose Rebuild 
Thumbnail from the Action menu. 

For multi-page or multi-layer fi les, go to the 
Media View and use the Pager tool to advance to 
the page or layer you want to be the thumbnail. 
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Thumbnail View: Click tab or press CMD-2

Header bar: The path 
name for the location 
of the fi le and a media-
related description will 
appear in the header. 
For unmounted fi les, 
this information is red.

Size menu: Thumbnail 
size can be set before 
or after adding fi les. If 
you reset a larger size 
after importing, iView 
will have to rebuild it 
in order to render it 
properly. 

Movie thumbnails have 
a small video icon to 
help differentiate them 
from still images.
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Then choose Rebuild Thumbnail from the Action 
menu. When you return to Thumbnail View, the 
thumbnail is updated. 

To update the thumbnail of a media fi le that 
has been modifi ed since it was cataloged, select 
the item and choose Rebuild Thumbnail from the 
Action menu.

Improving Thumbnail Quality
Some applications, such as Adobe Photoshop, 
embed a small, low-quality thumbnail into the 
media fi le. Digital cameras do this as well. During 
import, MediaPro renders that pre-existing “built-
in” thumbnail and stores it in the catalog fi le. 
Maintaining this default setting makes importing 
fast, but it also makes low-quality thumbnails.

To improve the thumbnail quality, set MediaPro 
Preferences to render its own thumbnails on 
import. Or you can rebuild thumbnails individu-
ally. These thumbnails will be superior in quality 
and take up much less catalog space than the 
built-in thumbnails.

Rebuild Thumbnails on Import: One option is 
to have MediaPro render new thumbnails during 
the import process. This is achieved by uncheck-
ing the box Use Built-in Thumbnails in the Prefer-
ences’ Media-Images panel (CMD-Comma).

Keeping this option off will instruct MediaPro 
to create a new thumbnail. However, this will slow 
down the import process, because MediaPro needs 
to render the entire image to create a thumbnail. 

Rebuilding Thumbnails Individually: If 
you have an existing catalog that used built-in 
thumbnails, then select the thumbnails and 
choose Rebuild Thumbnail in the Action menu 
(CMD-B). This function is also accessible from the 
contextual menu (Control + Click on Thumbnail).

Changing Size of Thumbnail: The size of 
thumbnails can be changed in the Size menu, 
located in the far right side of the header bar. When 
you increase thumbnail size, larger than the original 
import size, you will make need to execute a Rebuild 
Thumbnail command on all the fi les in the catalog. 

Digital Camera fi les: Digital cameras, regard-

less of manufacturer, are notorious for creating 
poor quality thumbnails in image fi les. They 
appear very pixelated and fuzzy. Using MediaPro’s 
Rebuild Thumbnail command will greatly improve 
the quality.

Some digital cameras, such as those made 
by Sony, allow photographers to shoot pictures 
with the 3:2 ratio. When the camera creates a 
thumbnail for this type of image, it puts black 
bars above and below the image to make the 
thumbnail size conform to the standard 4:3 ratio. 
To remove these bars and improve the thumbnail 
quality, chose the image(s) and execute a Rebuild 
Thumbnail command (Action menu, CMD-B). 

Adobe Photoshop
Covers v. 7.0
Adobe’s image editing program, Photoshop, 
embeds sharpened thumbnails that are 128x128 
pixels when it saves fi les. This option is controlled in 
Photoshop’s Preferences: File Handling dialog box.

When Macintosh Thumbnail is checked, 
Photoshop will always create thumbnails at 
128x128 pixels. There are no options for control-
ling the size of thumbnails.

If you have a default thumbnail size for your 
catalog set at Huge Size (160 pixels) or above, 
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A. Built-in thumbnail = 3:2 ratio, black bars, pixelated
B. Rebuilt by MediaPro = smooth, no black bars

A B

A. Built-in thumbnail from digital camera = pixelated
B. Thumbnail created by MediaPro = smooth

A B
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thumbnails for Photoshop fi les will appear 
smaller. When you rebuild it, the thumbnail size 
will match the rest of your catalog.

In the event that a Photoshop fi le does not 
have a built-in thumbnail, MediaPro will auto-
matically create its own. 

The default thumbnail size for Photoshop 7.0 
fi les is 128 pixels; for 6.0 fi les is 112 pixels. 

ImageReady Files
Adobe’s optimization program, ImageReady, 
does not embed thumbnails into optimized fi les. 
MediaPro will automatically create its own thumb-
nail from these fi les. 

Adobe Illustrator
Covers versions 6, 7, 8, 9 and 10
Illustrator does not offer any options for modify-
ing thumbnails in its native format (.ai). By default, 
Illustrator makes Bitmap PICT thumbnails at 
128x128 pixels. 

In Illustrator 10 on OS X, however, there are 
some important options. For the best catalogs, 
iView recommends that you should save fi les with 

the Create PDF Compatible File option turned on. 
This option makes the fi le you save a PDF fi le. This 
option is in the Illustrator Native Format Options 
dialog box,  which appears when saving an Adobe 
Illustrator fi le using the Save As command.

If you save Illustrator fi les without this box 
checked, or as Illustrator EPS, you will need 
to install the Ghostscript extension into the 
MediaPro Importers folder, in order for iView to 
catalog these fi le types. This extension can be 
found on the download page of iView’s web site.

In Illustrator 10 on OS 9, you will need 
to install the Ghostscript extension into the 
MediaPro Importers folder to view any fi le type 
saved by Illustrator.

MediaPro’s Rebuild Thumbnail command will 
not improve the quality of Illustrator thumbnails.

Macromedia FreeHand
Covers v. 9.0, 10 and MX (11)
Macromedia’s illustration program, FreeHand, 
embeds a small thumbnail when it saves fi les. 
These thumbnails are 112x112 pixels and are 
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A. Thumbnail created by Photoshop 7.0
B. Thumbnail rebuilt by iView MediaPro

A B

A. Illustrator Bitmap PICT thumbnail - v. 6,7,8,9
B. Thumbnail in Illustrator on OS X, PDF Compatible

A B
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color Bitmap PICT. Some of your FreeHand fi les 
may have been saved without a thumbnail or 
preview. As a result, these Freehand fi les will have 
this generic icon:

However, FreeHand has Export Preferences that 
will allow you to make sure a thumbnail is added. 
You can fi nd these options under Preferences 
(CMD-U) in the application menu.

To get the best thumbnails, iView recommends 
checking the following options:

A. FreeHand fi le preview: When checked, 
FreeHand documents are saved with a preview 
embedded. The default is a standard, 112x112 
JPEG thumbnail.  You can increase the width and 
height of this preview to ensure a larger image to 
display in Media view.

B. Include Portfolio preview: When checked, 
saved FreeHand documents include a thumbnail 
bitmap preview used by Extensis Portfolio for 
browsing. iView MediaPro will use this preview 
for display in Thumbnail view.

C: Checking the Bitmap PICT preview box may 
cause a color shift and gradient banding to occur 
on CMYK documents. The benefi t of checking this 

option is you are able to scale the size of your pre-
view, which is valuable for very large documents.

MediaPro’s Rebuild Thumbnail command will 
not improve the quality of these thumbnails. 

For more information on these Export options, 
refer to the FreeHand Help documentation. 

Adobe InDesign
Covers v. 2.0
By default, MediaPro makes Bitmap PICT 
thumbnails at 128x128 pixels of the fi rst page 
of InDesign documents. This is an example of an 
InDesign thumbnail of this user manual:

MediaPro renders only the thumbnail Media 
view. MediaPro’s Rebuild Thumbnail command will 
not improve the quality of InDesign thumbnails.
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Thumbnail quality & Catalog size
This section explains how to reduce the fi le size 
of iView MediaPro photo catalogs, while improv-
ing the quality of your thumbnails. This can be 
particularly important for catalogs containing 
more than 10,000 fi les, as a catalog’s fi le size can 
become very large.

Some applications, such as Adobe Photoshop, 
embed a small, low-quality thumbnail into the 
media fi le. Digital cameras do this as well. During 
import, MediaPro renders that pre-existing “built-
in” thumbnail and stores it in the catalog fi le. 
Maintaining this default setting makes importing 
fast, but it also makes the largest catalogs. 

To reduce the size of your catalog, set MediaPro 
preferences to render its own thumbnails. These 
thumbnails will be superior in quality and take 
up much less catalog space than the “built-in” 
thumbnails. 

Use built-in thumbnails: The fi rst place to start 
is to set MediaPro’s Preferences. In the Media-Imag-
es panel make sure Use built-in thumbnails not 
checked. Turning this option off will tell MediaPro 
to create a new thumbnail during import. 

Because MediaPro needs to render the entire 
image in order to create a thumbnail, this will slow 
down the import process. If you have an existing 
catalog that used built-in thumbnails, then select 
the thumbnails and choose Rebuild Thumbnail in 
the Action menu. This can reduce the size of your 
catalog by 25 to 35 percent. 

Ultimately, this ends up being a question of 
priority: catalog fi le size compared to time to 
create catalog.

Catalog sizes will vary depending on the size of 
the original built-in thumbnail. Every digital cam-
era and software program has a different method-
ology for creating and embedding thumbnails.

Time to catalog media will vary based on your 
computer’s operating system and processor 
speed.  It will also vary depending on the size of 
the original media fi le. For example, it will take 
longer for MediaPro to create a thumbnail of an 
25 MB Photoshop fi le than it will for a 2 MB digital 

camera fi le. 
Altering size of thumbnail: To further reduce 

the size of your photo catalog, you can choose a 
smaller size thumbnail. This can be done in the 
Size menu, located in the upper right hand corner 
of the catalog window. 

JPEG thumbnail compression: Previous ver-
sions of MediaPro offered the option to apply 
JPEG compression to thumbnails. This feature is 
now automatically built-in. 

By using JPEG compression for the display of 
media items in the Thumbnail view, iView cata-
logs are now even smaller. This does not prevent 
iView Media or iView MediaPro 1.5 from opening 
catalogs written by MediaPro 2.0.
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Use the Size menu to adjust thumbnail size.

MediaPro 2.0’s built-in JPEG compression of thumbnails 
reduces catalog size by more than 50%. 

iView MediaPro 1.5
• 1,200 media items
• 1.8GB media size
• 128 px. thumbnails
Catalog size: 21.6MB

iView MediaPro 2.0
• 1,200 media items
• 1.8GB media size
• 128 px. thumbnails
Catalog size: 9.7MB
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Media View 
This view displays media fi les at full size, one at a 
time. Unlike other views, Media View is a real-time 
presentation of the original media fi les on screen. 
This means that MediaPro needs to be able to have 
access to the fi le. If the fi le is not accessible, you will 
get an error message such as “File Not Found”. 

In Media View, you can play animations, movies, 
and sounds, or navigate inside a QTVR image in 
this view. Use the onscreen QuickTime controls to 
interact with movies, music and QTVR. 

You can also fl ip through the pages of a PDF or 
view the various layers of a Photoshop document 
using the Pager tool that appears in the Info bar.

When an image doesn’t fi t entirely inside the 
window, the cursor changes to a hand. Use it to 
drag the image around. 

To zoom in, press Command +. To zoom out, 
press Command –. You can also use the Zoom 
buttons in the upper right side of the Info Bar. 

To globally adjust the scale of media display 
in this view, you can use the Size menu. Options 
include: Actual Size, Scale to Fit, Fit Width, Fit Height, 
Pin Larger Side, Pin Smaller Side, Tile, and a selection 
of percentages.

For large media fi les (above 30 megabytes), there 
can be a slight  delay before the media appears on 
screen. The more powerful the computer, the less 
likelihood there is of a delay.

To print a particular layer or page within a com-
posite fi le, go to the page or layer you wish print 
and select Rebuild Thumbnail from the Action 
menu before printing. MediaPro only prints the 
frame assigned as an item’s thumbnail.

V
iew

in
g

 M
ed

ia

Media View: Click on tab or press CMD-3.

The Scroll bar in this 
view scrolls the catalog, 
not the image. If the 
image is larger than 
your viewing area, your 
mouse will turn into 
a hand ( ) which can 
move the image. 

The Size menu 
modifi es the display of 
the image in the Media 
View window. 

The Zoom tool enables 
you to increase or 
reduce the size of the 
image. 

Playback media: Use the onscreen QuickTime 
controls to interact with movies, music and QTVR. 

Pager Tool: When multi-layer or multi-page fi les are 
presented in this view, the Pager tool will appear in the 
header bar, so that you may look at different layers or pages. 
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Customizing the 
Appearance of a View 
You can customize a view by using the View 
Options dialog box. Here you can select which 
fi elds to display, as well as font style, text size, text 
and background color. The View Options dialog 
box can be accessed by choosing Show View 
Options from the Window menu (CMD-J).

In addition to the display of any view, these 
option also apply to printing and most export 
functions, such as HTML galleries. 

Display Options: Field labels puts the name 
of the fi eld next to the displayed content of that 
fi eld. Margin between adds a few pixels of white 
space around thumbnails. Frame media adds a 
one pixel border around thumbnails. 4:3 Ratio 
adjusts thumbnail space from a square, to a rect-
angle. This option fi ts more images on screen at 
a time. Some display options are not available in 
certain views.

Fields: To add or remove a fi eld to a view, click 
on its name in the fi eld list area. You can change 
the size (or number of lines) and the font style 
for each individual fi eld, by clicking the double 
arrow icon on any active fi eld. Only 10 fi elds can 
be displayed with each view.

Note: In previous versions of MediaPro, View 
Options was called Layout.
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Example of a Thumbnail View which has been 
customized through View Options and the size menu. It 
has a thumbnail size of 320 pixels. 

For repeat use 
of your settings, 
save them using 
the Options menu. 
Saved options 
can be recalled at 
any time and can 
be incorporated 
in AppleScripts.  
To make current 
settings the default 
for new catalogs, 
click Save as Default.

To make a fi eld display in 
a view, place a checkmark 
next to the fi eld name. 
Click the checkmark 
again to hide this fi eld.

To adjust the number of 
lines a fi eld can display, 
click the up and down 
arrows. To adjust the font 
display, make a selection 
from the options in the 
font drop-down menu.



Viewing Media   23

Playlist Mode
iView MediaPro has a new feature called Playlist 
Mode,  which enables you to play the fi les of a 
catalog in a continuous sequence. This is feature 
is turned on by default. To turn it on or off, select 
Playback in the Window menu, and select Playlist 
Mode (CMD-7).

This feature is useful when you have a cata-
log of MP3 fi les that you want to listen to, or a 
sequence of video or still images that you to 
watch. MediaPro will continuously play the fi les 
in your catalog in a loop until you tell it to stop. 

To start a playlist,  select the fi le you wish to 
begin with, and press the Play icon in the toolbar. 
Or, you can press the spacebar. To stop the play-
back, press the toolbar’s Play icon or the spacebar.

Playlist Mode will also automatically advance 
through a catalog of images, which is particu-
larly useful in Media View. Basically, it simulates 
a slide show, while allowing you to see informa-
tion panels open along side the images. You 
can adjust the delay (short, medium and long) 
between images in the Playback submenu of the 
Window menu.

When Playlist Mode is turned off, media can still 
be played, however MediaPro will not advanceto 
the next media item upon playback completion.

Playback of media
MediaPro can play a wealth of music, music and 
multimedia fi les. They can be played in any view, 
even slide shows. 

To start playback, select the fi le you wish to play, 
and press the Play icon in the toolbar. Or, you can 
press the spacebar. To stop the playback, press the 
toolbar’s Play icon or the spacebar.

In Media View, media fi les such as video, music, 
Flash and QTVR are displayed with QuickTime 
controls. You can use these controls to regulate 
playback and control volume. Or you can still use 
the toolbar’s Play icon and the spacebar to start 
and stop playback.

One unique feature of MediaPro is that you 
can switch between List, Thumbnail and Con-

tent view while playing a fi le, without altering 
playback quality. Simply click the view tab to 
change views.

If MediaPro cannot play your fi le, defi ne a media 
player application that is capable of playing the 
fi le and use it as a Helper Application. To learn 
more about defi ning Helper Apps and launching 
fi les with them, see page 60.
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Playlist Mode: During playback, fi les being played are 
highlighted with black corners. 

Media View playback: You can use the onscreen 
QuickTime controls to interact with movies, music, 
Flash and QTVR fi les. 

Toolbar controls: Press the toolbar’s Play 
icon to start or stop Playlist Mode, or to start 
and stop media playback in any view.

List View playback:  Though the icons are small, 
movies and music will play just fi ne in List View. Simply 
select a fi le and press the spacebar to start or stop the 
playback of any a fi le. You can also change views while 
the fi le is playing by clicking any of the view tabs.
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The Info Panel
When a media fi le is created by a computer or digi-
tal device, information is embedded into the fi le 
to describe it. This information is called metadata, 
which is used by software programs to accurately 
understand the media fi le. 

MediaPro uses the Info Panel (CMD-4) to pro-
vide an instant look at the aggregate properties 
and metadata of a media fi le, such as fi le type, size, 
dimensions, resolution, caption, capture date and 
duration. Naturally, this information will change 
based on the media type.

You can edit and check the accuracy of informa-
tion within this single user-confi gurable list with 
no need to remember to open multiple dialogs.  
The data inside the Info Panel is split into eight 
groups. To show the data from one of these groups 
by clicking the arrow next to the group name.  The 
eight groups of the Info Panel are:

File Info displays non-editable metadata that 
your computer assigns to a fi le, such as type, size, 
creation date. MediaPro now displays the annota-
tion size and thumbnail size in this group.

Media Info displays non-editable media 
related data. This information will change based 
on the media type.

Embedded Metadata displays non-editable 
media related data. This information will change 
based on the media type.

• Images: For digital cameras photos, the Info 
Panel will display special data (EXIF) that was 
captured and embedded in the media fi le. 
This metadata includes the date and time a 
photo was taken (Capture Date), as well as 
camera-related information, such as shutter 
speed, aperture and exposure. Different cam-
eras record different amounts of EXIF data.

• Music: When music is digitally encoded, it usu-
ally contains some level of compression, so 
that it takes up less space on your computer. 
The Info Panel displays the type of compres-
sion, length of the music, audio channels and 

Media Info & Annotations data about the quality of the sound.   
• Video: Unique fi elds such as Frame Rate, Spa-
tial Quality and Multiple Track Info appear in 
the Info Panel for video fi les.
Annotations: MediaPro supports a set of pre-

defi ned fi elds for annotating your media fi les. This 
set (also known as IPTC fi elds) includes entries for 
caption, keywords, categories and more. MediaPro 
also supports QuickTime information that is 
mapped to IPTC equivalents. Editing annotations 
in a MediaPro catalog does not affect the original 
fi les, unless you choose to synchronize the catalog 
entries with the original items.

IPTC stands for the International Press and Tele-
communications Council. Since the late 1970’s its 
activities have focused on developing industry 
standards for the interchange of news data. The 
IPTC fi elds used in MediaPro comply with the 
standard set by this organization.

MediaPro 2.0 has extended IPTC support to 
include the fi elds: Event (Fixture), Genre, Location, 
Edit Status and People.

People, Keywords, Categories are three 
groups useful for describing and organizing the 
content of your media. These groups are consid-
ered part of the IPTC annotation standard.

Caption: The Info Panel also provides an area to 
write descriptions of media, useful for additional 
explanation or thoughts. Captions embedded 
into fi les will automatically be shown here.

Some fi les will have large amounts of informa-
tion. To view all metadata, you can scroll down 
the panel, or you can hide the various sections by 
clicking on the arrow next to the section name. 

User-defi ned fi elds: MediaPro also supports 
up to 16 user-defi ned fi elds. To add or remove 
user fi elds choose Defi ne User Fields in the Edit 
menu. These fi elds appear at the bottom of the 
Annotations group.

When you move media items between 
catalogs, user fi elds are automatically adjusted 
between the catalogs. Note that if two catalogs 
contain more than 16 unique user fi elds, the fi rst 
16 fi elds sorted alphabetically will be retained.

A
n

n
ot

at
io

n
s



Annotations   25

A
n

n
otation

s

Info Panel: Click button or press CMD-4.

Info Panel: To show the Info Panel, click this 
button. To turn hide it, click the button again.

Selected image icon, fi le name and type

Media information is conditional to 
the fi le type. The example below, shows 
info for an MP3. 

Embedded metadata is also conditional to 
the fi le type. The example picture left, shows 
the info for a JPEG photograph. The example 
below, shows info for a QuickTime movie. 

Captions are descriptions of media, useful 
for additional explanation or thoughts. 
Comments embedded into fi les will 
automatically be shown here.

Resize the comments window by clicking 
on this bar and dragging it up and down.

Click arrow to expand and collapse data fi elds.

Use AutoFill to save/apply a group of annotations, 
keywords, categories and sets for repeat use.
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Annotating your media
All editable panels allow in-line editing of annota-
tions, captions, keywords, and categories.  To add 
information or edit a fi eld, double-click on the text 
box next to the fi eld label and type in the annota-
tion information.

The two icons at the top of the Info Panel allow 
you to:

  Save modifi cations permanently. This 
option is always applied when selecting a dif-
ferent media item or closing the catalog. 

  Discard or clear modifi cations that you 
have made to annotations.
Adding or editing annotations in an MediaPro 

catalog does not affect the original fi les, unless 
you choose to synchronize the catalog entries 
with the original items (see page 30). 

Annotations can also be added to fi les using 
drag-and-drop to the Field Finder of the Organize 
Panel (see page 34). 

AutoFill
MediaPro 2 introduces a new feature for saving  a 
group of frequently used annotations and apply-
ing them to a media fi le. 

AutoFill is useful for applying a standard set 
annotations (such as Author and Copyright) or 
context specifi c annotations (such as Location, 
Event Date and Product) to a single or group 
of media fi les. AutoFill will apply Annotations, 
People, Keywords, Categories and Captions to 
each fi le selected.  

To create an AutoFill:
1. Select a fi le and enter data into all annotations 

fi elds you wish to save.
2. In the suitcase drop-down menu at the top of 

the Info Panel, choose Save as AutoFill. Name 
your AutoFill in the pop-up menu. 

To apply an AutoFill:
1. Select a fi le or group of fi les.
2. In the suitcase drop-down menu at the top of 

the Info Panel, choose one of the AutoFills in 
your menu.

3. Click the green checkmark icon to confi rm (or 
red X icon to discard) the annotations.
Choosing Remove AutoFill will provide you with 

a pop-up window to remove AutoFills from the 
drop-down menu. 
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Show/Hide Annotations: Use the Annotation drop-
down menu to show or reveal annotations in the Info 
Panel. A checkmark indicates the fi eld is shown.

Discard Annotations: When you have added an 
annotation to a media item, a red diamond appears 
next to the fi eld name. To clear the annotation fi eld and 
start over, click on the red diamond.

QuickTime equivalents: Some fi les such as MP3s 
or videos have QuickTime annotations embedded. 
These are mapped to IPTC fi elds. For example, Author 
annotation fi eld is mapped to the Artist fi eld of an MP3,  
Product is the album name and Title is the Song Name.

AutoFill:  Useful for saving  a group of frequently used 
annotations and applying them to a media fi le. 
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Favorites 
Favorites is an auto-completion feature that 
assists in typing annotation information. It adds 
any text entered in annotation fi elds to a handy 
drop-down menu for easy re-use relative to spe-
cifi c projects or recipients of your media fi les.  You 
can use auto-completion to automatically assign 
entries to one or more annotations.

Any new annotation entered is added to a list 
of Favorites for that fi eld. For example, the annota-
tion fi elds City, State and Country each have their 
own Favorites list. When you type in an annota-
tion fi eld, the auto-completion feature reveals the 
nearest word in the Favorites list. When you leave 
that fi eld, MediaPro automatically adds the new 
word to the list of favorites. 

Favorites lists are saved globally and are acces-
sible by every catalog you create. 

You can browse through the list of Favorites 
from the drop-down menu, which becomes vis-
ible when the fi eld is active. To add a word to the 
selected fi eld, simply scroll through the menu and 
select a word. Notice that when you type a letter 
in the edit box, the drop-down menu displays the 
list at that point of the alphabetical list.

Modifying Favorites: Favorites lists are stored as 
separate text fi les inside the user-defi ned MediaPro 
Plug-Ins - Favorites folder (see page 2). You can use 
any text editor to edit these fi les. Each item in the 
list must be followed by a carriage return.

Language Favorites: When you switch from 
one language to another, MediaPro recognizes 
the change, and creates different Favorite fi les 
for each language. These fi les adopt the new lan-
guage fi eld names for easy identifi cation, and are 
located in the Plug-Ins - Favorites folder.  

If you wish to preserve the Favorites list, allowing 
users to access to the Favorites list while restrict-
ing any new additions, you can lock the individual 
favorites fi les in the Finder, outside the application. 
Select the fi le in the Finder, go to the Get Info dialog 
in File menu, and enable the Locked option in the 
General Information panel.

Batching Annotations 
Version 2.0 allows you to batch edit annotations 
for multiple media fi les, giving you complete 
control  of the editing process.

A batch operation refers to a function that has 
been applied to a group of fi les.  MediaPro has 
integrated batch capabilities with the core fea-
tures of the application, including editing.  

Selections: To batch edit fi les, you must begin 
by making your selection. There are several stan-
dard ways to select a group of fi les: 
1. Select the fi rst item and, holding down the 

Shift key, select the last item from your selec-
tion. This selects a block of items which can 
be batched.

2. Select individual fi les, holding down the CMD 
key, while making your selection. This method 
allows you to create a non-continuous selec-
tion in different areas of the catalog.

3. Block selection of disjointed cells. For example, 
to select 1-10 & 20-30. Click 1, Shift-click 10, 
CMD-click 20, Shift-click 30.

4. Expand current selection by pressing the Shift 
and one of the arrow keys.
Batch Operations: Once you have made your 

selection, you can batch any operation, by select-
ing and applying the function, such as Rotate 90°, 
to the group. 

There are two ways to batch annotations: 
1. Info Panel: Select the media items you want 

to include in your batch. Open the Info Panel and 
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Favorites: Example of the auto-completion feature. The 
user has typed in “T” and Favorites fi lled in the rest.

Favorites: Example of using the Favorites drop-down 
menu to fi ll in the annotation fi eld.
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type your information into the desired annota-
tions fi elds (e.g. caption, keyword or category), 
or you can use AutoFill. Then press the green 
Checkmark button at the top of the Info Panel 
to confi rm.  This is the only method of applying 
multiple annotations to a selection of fi les. 

2. Organize Panel:  Reveal the desired annota-
tion group in the Field Finder using the drop-down 
menu in the upper right hand corner of the panel. 
Click on the annotation group label (e.g. Dates, 
Keywords) to show available annotations. 

Choose Add Field from the annotation group 
drop-down menu, and type in your new fi eld 
information. Select a group of media items, then 
drag-and-drop the images onto the new fi eld.

Batch Removing Annotations
You can remove the annotation fi elds from 
selected media fi les by using the Clear Annota-
tions command in the Action menu. After select-
ing this command, a dialog appears asking if you 
want to Clear All annotations or Choose Fields. 
The latter button reveals the annotation fi elds 
attached to the fi le or fi les, allowing you to select 
the particular fi eld(s) to remove. 

Annotation AppleScripts
MediaPro offers some special annotation scripts in 
the Annotate submenu of the AppleScript menu:

• Copy Photo Data to Clipboard copies all EXIF 
photo metadata to clipboard.

• Import From PhotoDISC™ annotates images in 
your front catalog, using text fi les located in 
your PhotoDISC™ CD-ROM.

• Make Caption from Photo Data copies all EXIF 
photo metadata into the Caption fi eld. 

• Make Caption from Text Files searches for .txt 
fi les in the same folder as the original, and 
copies the contents into the caption fi eld.

• Make Caption from Text Lines opens a text fi le 
and uses each line of the fi le as the caption for 
the selected items.

• Make Event Date from Capture copies the EXIF 
Capture Date and puts it into the Event Date 

of the Annotations pane. 
• Make Keywords from Folders enables you 
to add keywords to media fi les from folder 
names. The pop-up dialog provides the 
option of defi ning the level of folders in the 
path you would like to use for keywords. 

• Make Product from EXIF Data copies the EXIF 
Maker and Model fi elds and puts them into 
the Product fi eld of the Annotations pane.
You can modify existing scripts or create and 

attach your own annotation scripts at any time. 
Simply write the script, then place it in the user-
defi ned Plug-ins - Scripts folder (see page 2).

Modifying digital camera metadata
For photographs taken with with digital cameras, 
the Info Panel will display special data (EXIF) that 
was captured and embedded in the media fi le. 
This data is not editable, with two exceptions: 

• Set Capture Date (Action menu): Digital cam-
eras record the date and time a photography 
is captured based on the internal clock of 
the camera. If this clock is not correct, the 
date and time can be reassigned using this 
function.  This operation cannot be undone 
and applies only to images taken with digital 
cameras. You can also batch this operation by 
selecting multiple images.

• Correct EXIF orientation (AppleScript menu 
- Files submenu): Some newer digital cameras 
now sense and record the orientation of the 
camera at the moment of capture. This func-
tion will rotate the thumbnails of all selected 
items to correct any values of the Orientation 
fi eld written by your digital camera.

Color Samples
iView MediaPro offers the ability to identify media 
(images, movies, etc) by a single color, called a 
Color Sample. This is useful when searching for 
images of a specifi c color or tone. 

A color sample is generated when the media 
is imported, based on the dominant color of the 
image.  Modify the sample color of selected media 
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fi les with the Set Color Sample option in the Action 
menu. Use the color picker to defi ne a color. 

Color samples can also be viewed and modifi ed 
in the Field Finder window of the Organize Panel 
(CMD-5). Switch the color sample of an image in 
the Field Finder by dragging the image onto one 
of the colors in the Color Sample list.

Color Profi le Management 
MediaPro supports ColorSync profi les for images 
(JPEG, TIFF, PICT, PDF and Adobe Photoshop fi les.) 
MediaPro 2.0 extends your color profi le manage-
ment from input source, iView catalog, to proof 
and fi nal printing. 

Color profi les apply to thumbnails: MediaPro 
1.5 was able to display your images matched to 
a ColorSync Profi le within Media View. MediaPro 
2.0 now extends this to the Thumbnail and List 
View providing you with color accurate display 
in all applicable views. 

Manage Color Profi le dialog: The new Manage 
Color Profi le dialog (Action menu) allows you to 
embed RGB and CMYK ColorSync profi les for indi-
vidual fi les. When the dialog launches, MediaPro 
displays the image in Media View, allowing to 
preview the application of various profi les. You 
can also remove profi les in this dialog.

Batch Profi le embedding:  MediaPro 2.0 allows 
you to Batch embed ColorSync Profi les to multiple 
fi les. To batch fi les, select a group of images, then 
select Manage Color Profi le in the Action menu. You 
can embed a choosen ColorSync Profi le based on 
the color space of the image (RGB, CMYK, Gray-
scale). This prevents you from embedding an 
inappropriate profi le that would ruin the image.
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Field Finder: You can sort catalogs based on Color 
Profi les and Color Samples by using the Field Finder. The 
Color Samples fi elds support drag-and-drop annotating 
bu the Color Profi le fi elds do not.

Manage Color Profi les: (Action menu) When managing the profi le of a single 
image, MediaPro will switch to Media view so that you can preview your changes.  

This pull-down menu 
provides complete access 
to profi les defi ned by 
ColorSync, your Mac’s color 
management technology. 
To learn more about 
color profi les and Apple’s 
ColorSync technology, visit:
apple.com/colorsync
or see your system’s help 
documention.
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Synchronizing annotations 
By default, MediaPro does not embed annota-
tions to a fi le. To write annotations into a fi le, use 
the Synchronize function, in the Action menu 
(Option+CMD-B). This command allows you to 
import or export annotation fi elds from the cata-
log into the original fi les. 

This is particularly useful, as MediaPro allows 
you to view, classify and batch a large number 
of fi les and then export the changes to their 
original fi le, saving hours of time opening and 
editing individual fi les. Synchronizing cannot be 
undone. 

Annotations that have been synchronized into 
the fi le can be read by other applications that can 
read metadata standards, such as Photoshop or 
GraphicConverter.

Voice annotations 
Voice annotations are short audio recordings 
embedded in media fi les. Some digital cameras 
or other image capturing devices allow you to 
save voice comments with a picture.

To listen to audio annotations, select the item 
and press the spacebar, or choose Listen in the 
Voice annotation drop-down menu of the cata-
log toolbar. 

The button’s drop-down menu allows you to 
Record up to 30 seconds of voice annotation. 
This voice annotation is stored in the MediaPro 
catalog. You can also add a separate sound fi le 
with the Import option. This tool also allows you 
to remove a voice annotation. The compression 
ratio for voice annotations can also be adjusted 
in this menu.

Voice annotations can also be used in slide 
show presentations. This feature is enabled by 
default. To disable it, select Play Voice Annotations 
in the slide show controller options menu.

Export Voice Annotations (Make menu): This 
feature saves an embedded audio annotation as a 
separate fi le (in the .AIFF format).  In previous ver-
sions of MediaPro, this function was in the Annota-
tions submenu of the Action menu.

A
n

n
ot

at
io

n
s

Synchronize: Import annotation info from original fi les. 
Click on the arrow to switch to Export mode.

Synchronize: Export annotation information from 
catalog back to original fi les.

Voice annotation 
toolbar icon, and 
drop-down menu.

Record Stop Pause Play - use to review 
recorded annotation 
before saving.

Record voice annotation dialog
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Moving media in catalogs 
To rearrange items in a catalog, click and drag 
them to where you want and drop them. You can 
drag single items or groups of items.

In previous versions of MediaPro, you could 
rearrange media fi les using the Move Items func-
tion in the toolbar. This feature has now been 
moved to the View menu. Moving functions are 
accessible in the View submenus of the contex-
tual menu.

This feature enables you to move media items 
to the top, or bottom of a catalog. You can also 
move and item or group of items to a specifi c 
location within the catalog.  

When you choose the Move to Location func-
tion (CMD-L), the cursor will turn into a crosshair. 
At this point, use the scroll bars to go to any loca-
tion in the catalog, then place the crosshairs at the 
desired location and click. Your media items will 
drop into the new location. This feature is particu-
larly useful for moving fi les in catalog with a large 
number of fi les, most of which are not visible in 
the viewing area.

Move Again (Shift+CMD+L) will repeat the 
last move made in the catalog, whether it be to 
the top, bottom, location or a manual drag-and-
drop.

Organizing Catalogs

Click and drag the divider to alter 
the size of the two windows. 
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When dragging items to a new location, a black bar 
appears in the location where the fi les will be placed.

The Organize Panel has two windows: the Field Finder 
and Catalog Sets. To show/hide this panel, click the 
interface button or press CMD-5.
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The Organize Panel
The Organize Panel has two windows: the Field 
Finder and Catalog Sets.  To show/hide the Orga-
nize panel, click the interface button or press 
CMD-5.

Field Finder
The Field Finder is good for global searches or 
groupings, allowing a quick comparison across 
hundreds of fi les, often revealing annotation incon-
sistencies among a large number of fi les. By view-
ing your media on a global rather than individual 
perspective, you ensure the standardization and 
accuracy of annotations across your media.

The Field Finder lists all annotations or tags 
present in the catalog. By batch (or individual) 
dragging media over the existing data values, 
you can assign these values to the multiple media 
items. This greatly speeds up and simplifi es the 
annotation process.

The Field Finder has two types of groups. Read-
only groups, such as Media Formats, are attributes 
that are automatically read by MediaPro and 
cannot be reassigned. Annotation groups, such 
as Date or Keywords, are fi elds used to categorize 
the media and can be changed at any time. 

Use the Field Organizer drop-down menu to 
show/hide various media attributes and annota-
tions in the Field Finder. To expand a fi eld, click on 
the arrow next to its name. 

Read-only groups
Media Formats: Shows a list of all media sorted 

by the fi le format, such as TIFF, JPEG and MP3. 
Devices: This list categorizes media by the 

digital device that created the fi le. Digital cam-
eras and some scanners record this information 
in every image they capture (EXIF metadata).  
Media items that do not have a device assigned 
will not be represented in this list.

Annotation groups
These fi elds give you an alternative for assigning 
metadata organization to your media fi les, as 
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Field Organizer drop-down menu: Use this menu to 
show/hide various media attributes and annotations 
that you can use for sorting and organizing functions.

Read-only groups: These fi elds show embedded media 
attributes that are automatically read by MediaPro and 
cannot be reassigned.

Annotation groups - Dates: When fi les are added your 
catalog, MediaPro searches for dates already embedded 
in your media. 
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opposed to entering this data in the Info Panel. 
Color Profi les: Displays media based on the 

ColorSync Profi le embedded in the media fi le. 
Media items that do not have a color profi le 
assigned will not be represented in this list. Color 
profi les can only be assigned to fi les using the 
Manage Color Profi le option in the Action menu, 
and cannot be assigned through drag-and-drop 
to the Field Finder. 

Color Samples: A color sample is generated when 
the media is imported, based on the dominant color 
of the image.  To change a media item’s color sample, 
you can choose Set Color Sample from the Action 
menu, or you can drag-and-drop the item onto any 
color sample in this list. For more information on 
Color Profi les and Samples, see page 28.

Dates: When fi les are added to your catalog, 
MediaPro searches for dates already embedded in 
the media. In this order, it looks for the IPTC Event 
Date, then the digital camera (EXIF) Capture Date, 
then the File Creation Date. If a fi le has all three, 
MediaPro will use the Event Date as primary date 
for display in this list.

You can adjust the date assigned to a fi le by 
drag-and-dropping the fi le onto a different date 
fi eld.  This assigns the new date to the IPTC Event 
Date and does not alter the Capture Date or Cre-
ation Date for the media fi le.

The digital camera (EXIF) Capture Date can be 
reassigned using the  Set Capture Date option 
in the Action menu.  This operation cannot be 
undone and applies only to images taken with 
digital cameras.

If the date you want isn’t available in the list, 
use the annotation fi eld drop-down menu to add 
a new date. This drop-down menu also provides 
you with option to remove a date from the list. 
Removing a date will not only delete the date, but 
all associated fi les from the catalog. 

IPTC and QuickTime Annotations: The remain-
ing fi elds in the Field Finder are all part of the IPTC 
and QuickTime standards. They are: Events, Loca-
tions, Cities, Countries, People, Products, Authors, Genre, 
Sources, Edit Status, Keywords and Categories.

Instead of assigning these annotations in the 
Info Panel, you can create an annotation fi eld in 
any of these groups, then drag-and-drop media 
on the fi eld name and the annotation will be 
assigned to the fi le. This greatly speeds up and 
simplifi es the annotation process.

If you switch over to the Info Panel, you will 
notice that same annotation is represented in 
the corresponding annotation fi eld.

Conversely, if you add metadata to an annota-
tion in the Info Panel, it will also appear in the 
corresponding group in the Field Finder.

Working with annotations groups
Open/close an annotation group: Click on the 

fi eld label of the group. 
Add an annotation fi eld: Select an annotation 

group, such as Events, then choose Add from the 
group’s pull down menu. Type the name of your 
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Add a fi eld: Select an annotation group, such as Events, 
then choose Add from the group’s drop-down menu.

Auto-completion: iView MediaPro remembers the fi elds 
for each group you’ve ever created. As you write the 
name of a new annotation fi eld, the auto-completion 
feature assists in typing fi eld names. All new names 
are added to each group’s drop-down menu, called 
Favorites, for easy reuse. 

Add/delete a date: Select a date, then choose Add from 
the drop-down menu.
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annotation fi eld. MediaPro’s auto-completion 
feature will assist you in typing the fi eld name. All 
new names are stored in the drop-down menu 
for easy reuse.

Add an item to an annotation: Select a fi le, or 
group of fi les, then drag-and-drop them on to an 
annotation fi eld. Associating a fi le with an annota-
tions in a catalog does not affect the original fi les. 

Remove an item from an annotation: Click 
on an annotation fi eld, showing only those fi les 
associated to it. Select a fi le, or group of fi les, and 
press the Delete key. A dialog will ask if you want to 
remove this fi le from the annotation. If you switch 
over to the the Info Panel (CMD-4), you will notice 
that the same annotation has been removed from 
the corresponding annotation fi eld.

Locating media by fi elds
Once you have assigned media to various annota-
tion groups, you can now sort the catalog using 
the Field Finder. 

To fi nd fi les that match an attribute (date, 
media format) or annotation (events, locations, 
etc.), click on the fi eld label in the Field Finder of 

the Organize Panel and the corresponding fi les 
appear in the active view. This will hide all fi les 
that do not match that annotation or attribute.

This is useful for fi nding a particular group of 
fi les which can now be batch processed, exported, 
reorganized or printed.

After you have found your fi les, use Show All in 
the Find menu (CMD-E) to reveal all the hidden 
fi les in your catalog. You can also use the Show All 
Items icon in your toolbar to show all fi les.
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Add a fi le to an annotation: Select a fi le, or 
group of fi les, then drag-and-drop them on to 
an annotation fi eld (above) in the Field Finder. 
If you switch over to the Info Panel (left), 
you will notice that same annotation is 
represented in the corresponding fi eld for 
that fi le. Conversely, if you add metadata to an 
annotation in the Info Panel, it will also appear 
in the corresponding group in the Field Finder.

Restoring the catalog: After you sort a catalog, use the 
Show All Items icon in your toolbar to reveal hidden fi les.

Locating media by fi elds: To fi nd fi les that are associated 
with a group, click on the fi eld label in the Field Finder.
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Catalog Sets 
Catalog sets are a free form, hierarchical method 
of organizing media fi les. You can use sets to orga-
nize playlists, photo albums, work assignments or 
to create a complex system of categorization.

Sets can be used to quickly display sub-groups 
of items in a catalog, and to maintain their order, 
even after items within the sets have been moved 
or sorted. These catalog sub-groups can then be 
used in export functions such as slide show pre-
sentations, quick searches, classifi cations, printing, 
and Web pages.

Any media item can belong to more than one 
set, allowing catalogs to be logically organized 
into sets for different projects, clients or themes, 
without confusing the overall annotation or clas-
sifi cation of fi les in the catalog. 

Sets can be shifted around to change the level 
or relative position of an individual set within the 
group of sets. 

New in 2.0: In previous versions of MediaPro, 
all sets were the same, and could be shifted or 

reordered in a hierarchy. MediaPro 2.0 introduces 
a new type of set called containers. Sets can no 
longer be heirarchal to each other. Sets must be 
grouped by a container, or sub-container.

View sets: Open the Organize Panel by clicking 
on the button (CMD-5).  Catalog Sets are located 
at the bottom of this panel.

Create a set by selecting Append new set from 
the catalog sets main drop-down menu. To create 
a container, select Append new container from the 
same menu.

Add media items to a set: There are three ways 
to add fi les to a catalog set. 
1. Drag-and-drop one or more media fi les from 

the catalog’s active window to the set name. 
2. Select a fi le, or group of fi les, and choose Add 

to Set from the Action menu (Shift+CMD+M). 
In the pop-up dialog, either choose an exist-
ing set, or create a new set for these items.

3. Select a fi le, or group of fi les, and choose 
Acquire selected items from the individual set’s 
drop-down menu.
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Catalog Sets main menu

Containers menu

Individual sets menu

Containers 
and empty 
sets have 
generic icons.

Icons are 
assigned by 
the fi rst fi le 
associated 
with a set.

File types that 
do not have 
thumbnails, 
such as MP3s, 
have generic 
set icons.

Container 

Subset 
container 
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When you add or remove media items to a 
set, the set counter to the right of the set name 
automatically updates.  

Remove items from sets: Click on the set 
name to show only associated set items in the 
active view. Select the items you wish to remove 
from the set and press the Delete key. A dialog 
will prompt you to choose whether you want to 
remove the item from the set or the catalog. If you 
remove the item from the set, it still remains in the 
main catalog.  

Alternatively, you can remove items from sets 
by selecting Remove Set Items in each sets menu.

Display a set: Click on the set name in the  
Organize Panel.  This displays the items of the 
selected set in the active view, hiding all other 
fi les in the catalog. Use the Show All function in 
the Find menu (CMD-E) to reverse this feature, 
revealing all hidden fi les. You can also use the 
Show All Items toolbar icon to reveal hidden fi les.

Once you have displayed a set in the active 
view, you can easily perform batch commands 
or export functions without affecting the rest of 
the catalog.

Display a group of sets: Click on the container 
or subcontainer name in the Catalog Sets window.  
This will display all items associated with all sets 
in the container.

Alternatively, you can display a group of sets 
by clicking each set name and holding down the 
Command key.

Select set items: To select all media items 
associated with a set, choose Select Set Items in a 
sets’ drop-down menu.  This is useful for selecting 
items without having to fi rst display the set.

Copy sets from one catalog to another: In 
the catalog sets main menu, choose Copy list to 
clipboard. Switch to catalog you want to apply 
the sets, and select Paste list from clipboard in the 
sets main menu. 

Set associations do not stay with a media fi le 
when you copy media fi les from one catalog to 
another, or when you merge one catalog with 
another.
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Add fi les to a set: Select a fi le, or group of media fi les, 
and drag-and-drop them from the catalog’s active 
window to the set name. 

Reorder sets: Sets can be shifted around to change the 
level or relative position of an individual set within the 
group of sets. 

Add to Set dialog: Select a fi le, or group of media fi les, 
and select Add to Set in the Action menu (CMD-M). In 
this dialog, you add the selected items to an existing set, 
or create a new set.

Restoring the catalog: After you sort a catalog using 
sets, use Show All in the Find menu (CMD-E) to show all 
the fi les in your catalog. You can also use the Show All 
Items icon in your toolbar to show all fi les.
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Organizing original fi les 
iView MediaPro includes features to modify your 
original media fi les in order to make them better 
organized on your computer. 

Rename: To change a fi le name, click the name, 
wait a moment, and then start typing. 

Batch Rename: This command (Action menu) 
renames all selected catalog items, as well as the 
corresponding original fi les. This operation is irre-
versible. In this dialog box, you have four panel 
options from the pull-down menu: 

• Incremental: Specify a naming and number-
ing sequence for renaming your fi les. For 
example: Photo1, Photo2, etc. Together with 
the Show Duplicates feature, this is good for 
imports of images from digital cameras which 
often use repeated fi le names that can confl ict 
with earlier imported images.  Zero pad incre-
ments will number fi les: 001, 002, etc. 

• Replace String: Specify a string such as 
“DSC00” (common to digital cameras) and 
replace it with your text, i.e.  “Photo”.

• Add String: Good for adding or changing fi le 
name extensions. Begin by selecting fi les of 
a particular type. In the Add String panel, add 
the fi le extension (.jpg, .gif ) in the text box 
and chose the Trailing option. 

• Convert: Useful for changing the text case to 
all lower or all UPPER. On Macs, this function 
will strip fi le extensions (such as .jpg) and also 
remove diacritical marks such as accents.
Move to Trash (Toolbar): Remove selected fi les 

from the catalog and moves the originals to the 
Trash. MediaPro does not actually empty the Trash. 
If you change your mind, you can always open the 
Trash, and move fi les back to their original location.  
To empty the contents of the desktop Trash, select 
~ Empty Trash from the AppleScript menu.

Move To Folder (Action menu) moves selected 
items to a new folder. If the fi les are moved to a 
folder in the same volume (hard drive), their refer-
ence in the catalog is updated.  

Copy To Folder (Action menu) makes a copy 
of all selected items to a new folder. MediaPro will 

confi rm before replacing any existing fi les with 
the same name.

Folders Panel: Open the Folders Panel by click-
ing on the Folders icon (or press CMD-6). Drag-and-
drop any fi le from your catalog onto a folder in the 
Folders Panel.  This moves the location of a fi le to a 
different folder on your computer. The path to the 
fi le is automatically updated in the catalog.

Finder Properties (Action and AppleScript 
menu): These commands allow you to improve 
the Finder’s classifi cation and search for fi les on 
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Batch Rename (Action menu) Incremental panel.

Batch Rename (Action menu) Convert panel.
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different volumes and directories, as well as the 
accessibility or visibility of fi les by other users. 

In the Action menu
• Set Creator: For changing the 4-character fi le 
creator that the media fi le is associated with. 
For example, it’s useful for changing fi les with 
QuickTime creator to a Photoshop creator. 
This will allow you to double-click the fi le and 
open it with Photoshop. 

• Desktop icons: For easy identifi cation of fi les 
within the application or in the Finder, this 
will replace generic desktop icons with image 
icons of original fi les. 

• Media Thumbnails exports and embeds a 
small thumbnail into original referenced fi les 
outside the catalog. This preview can be read 
by a number of media editing applications 
which use built-in thumbnails in their open-
ing dialog for quick identifi cation. 
In the AppleScript menu

• Set File Comment will save the Caption fi eld 
inside the fi le’s comment fi eld, visible in the 
Finder and the Get Info window of original fi les. 
When the operating system indexes your fi les 
on the desktop, your media fi le captions will 
now be part of your Sherlock search index.

• Set File Label (OS 9 only) will set the label of 
fi les in the Finder using the label marking ID 
set in catalog.

• Set File Lock will lock the fi le in the Finder. 
Drop Folder (Edit menu): MediaPro can be 

used along side other applications to temporarily 
or permanently store image, text, movie or sound 
clips, dropped from any application that supports 
drag-and-drop. This also applies to Web browsers. 
The chosen Drop Folder preference is saved with 
the catalog, so that you can assign a different 
Drop Folder to each catalog. 

Version Control (Image Editor): This is useful 
both for individuals and small work groups to 
browse and track different versions of the same 
fi les. This is particularly useful as a backup as well 
as reverting to different versions. (See section on 
Version Control, page 71).
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Finder Properties: OS 9 and OS X examples of a media 
fi le’s Finder info, with comments and icon created by 
MediaPro.
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Folders Panel
iView MediaPro 2.0 introduces advanced folder 
management to enhance your workfl ow and 
provide direct control over your fi le system.

Folder watching
Catalog-wide folder watching can be enabled to 
constantly monitor folders which contain media 
within your catalog.

To enable folder watching, select an option 
from the catalog folder watching menu — either 
Check every 1 minute or 5 minutes. 

When new media items are added to any 
folder MediaPro alerts you to the new content 
(shown by a blue arrow on the folder icon). You 
can then choose to import these new fi les directly 
to your catalog from your stored media location 
by selecting Update Folder from the individual 
folder’s drop-down menu.

To turn off folder watching, select Don’t Check 
from the catalog folder watching menu. 

Auto-update folder watching
Auto-update takes folder watching to the next 
level by automatically importing from selected 
folders when new media are added.

Auto-update is a good option if you only want 
one or a few folders of the catalog to be watched, 
as opposed to global folder watching.

To enable this feature, select Switch auto-update 
on in the drop-down menu of the folder that you 
want to be constantly monitored. Once new 
media is added to that folder, MediaPro will auto-
matically import those items into to your catalog. 
Auto-update folders are designated green.

Additional folder functions
Remove folder and its contents: This function 

in the folder drop-down menu removes a folder 
and its contents from the catalog but not from 
the hard drive.  

Reset folder path: This folder drop-down 
menu feature is useful if you have moved media 
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Catalog Folder Watching menu

Individual folder menu

Green folders 
indicate auto-
update is on.

Blue arrows 
indicate 
that new, 
uncataloged 
items are in 
this folder. 
Select Update 
Folder to add 
new items.

To expand all 
folders, Option 
Click on the 
folder arrow.

Indicates Folder Watching is on

Folders Panel: Press CMD-6 to show/hide this panel (Window menu).

Indicates the number of cataloged 
media that are in this folder.
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to a new location, but the catalog still thinks the 
fi les reside in the old location.  

Display contents of a folder: Click on the 
folder name in the Folders Panel.  This displays 
the items of the selected folder in the active view, 
hiding all other fi les in the catalog. Use the Show 
All function in the Find menu (CMD-E) to reverse 
this feature, revealing all hidden fi les. You can also 
use the Show All Items toolbar icon.

Once you have displayed a folder in the active 
view, you can easily perform batch commands or 
export functions without affecting the rest of the 
catalog.

Display a group of folders: Click on a high-level 
folder or subfolder name in the Folders Panel.  This 
will display all items associated with the high-level 
folder and subfolders. Alternatively, you can display 
a group of folders by clicking each folder name and 
holding down the Command key.

Select folder items: To select all media items 
associated with a folder, choose Select Folder Items 
in a folders’ drop-down menu.  This is useful for 
selecting items without having to fi rst display the 
folder’s contents.

Direct folder manipulation
MediaPro also offers several features that enable 
you to undertake system fi le operations directly. 

Most of these functions cannot be undone, as 
they directly manipulate fi les and folders on the 
desktop.

• Open Folder reveal folders and its contents in 
the Finder.

• Create sub-folder will create a new folder on 
the desktop. You can name it from the Folders 
Panel list.

• Rename folder enables you to rename a folder 
on the desktop.

• Trash folder and its contents removes fi les and 
folders from the catalog and physical stor-
age. This feature move fi les and folders to the 
desktop Trash, but does not empty the Trash.

• Move fi les directly around the fi le system from 
within the catalog. To move a fi le to a different 
folder on your computer, drag-and-drop the 
fi le onto a folder icon. The media fi les will be 
physically moved to the folder selected.

• Move To Folder (Action menu) moves selected 
items to a new folder. If the fi les are moved to 
a folder in the same volume (hard drive), their 
reference in the catalog is updated.  

• Copy To Folder (Action menu) makes a copy of 
all selected items to a new folder. MediaPro 
will confi rm before replacing any existing fi les 
with the same name.
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To move a fi le or group of fi les to a different folder on your computer, drag-and-drop the fi le onto a folder icon in 
the Folders Panel. This operation cannot be undone.
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Media labeling & marking 
Color labels provide a visual identifi cation and 
classifi cation of media fi les.

Labels are also useful as a means of perma-
nent selection. After you label your item, you can 
quickly select them or show them using  the Show 
Labelled command (Find menu).

Once a label color has been assigned to a fi le, 
the text associated with that media (i.e. fi le name) 
will appear in that color in all views.

How to assign a label
Once you have selected a fi le or group of fi les, you 
can add a label three ways: 
1. Choosing a color from the Assign Label drop-

down menu in the toolbar (see fi gure).
2. Choosing a color from the contextual menu. 
3. Pressing number key (1 through 9). This will 

apply the associated color (e.g. 1 = Red).

How to remove labels
Select a fi le or group of fi les and: 
1. Chose Remove Label from the Assign Label 

drop-down menu in the toolbar, or from the 
contextual menu in any view. 

2. Press number zero (0).

How to sort using labels
Select a fi le or group of fi les and: 
1. Chose the color label from the Search Labels 

drop-down menu in the toolbar, or
2. Chose the color label from the Show Labelled 

sub-menu of the Find menu.  
Labelled fi les can now also be sorted during 

slide shows. Use the Search Labels drop-down 
menu in the Slide Show Controller.

Methods for using labels: A label can stand for 
anything you want — favorites, fi les to discard 
or fi les that are in different stages of the editing 
process.  

One method you might fi nd effective is to 
use labels to mark favorite images (and images 
to delete) after a photo shoot. After importing 

images into a catalog, launch a slide show. As you 
review the images, use one label to mark the best, 
and another label to mark images that are out-of-
focus and unusable.  This can be done during the 
slide show (or in any view) by pressing the label’s 
corresponding number key.

Afterward, you can use the Show Labelled func-
tion (Find menu) to show only the best images 
from a shoot in your catalog.

New in 2.0: In previous versions, function keys 
were used to assign labels. This has been changed 
to number keys (1 through 9). The option to cus-
tomize the color and name of a label has been 
removed from MediaPro.
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Assign label toolbar 
icon, and drop-down 
menu. Use any of the 
associated numbers to 
apply a label to a fi le 
in your catalog while 
in any view, even slide 
shows. This menu is 
also accessible from 
the contextual menu.

Labeling fi les changes the display color of fi le names 
and borders in all views. 

Labelled fi les can be sorted by using the Search Labels 
drop-down menu of the toolbar.
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Finding and Sorting Media in Catalogs

iView MediaPro offers a number of ways to fi nd 
and sort media fi les, as well as related fi le, media 
and tag attributes, in open catalogs. 

Instant catalog-wide searching
Catalog-wide searching can be actioned quickly 
and directly from the Search box in the cata-
log window. Searching is case-insensitive and 
includes all annotations (EXIF, IPTC, Captions, etc.), 
media fi elds and catalog set names.

To perform a search, simply type the word or 
words in the Search Box and press the Return 
or Enter key. Results are presented in the active 
catalog view. 

After you have found your fi les, use Show All 
in the Find menu (CMD-E) to show all the fi les in 
your catalog. You can also use the Show All Items 
icon (house) in your toolbar to show all fi les.

Find command 
The Find command (Find menu, CMD-F) can 
search 50 different media attributes and annota-
tion fi elds inside your catalogs. 

Using the Find items pull-down menu, you have 
the option of searching the active or front catalog, 
all open catalogs, recent catalogs or all catalogs 

in a particular folder. The Find command also has 
the ability to perform compound searches of attri-
butes (a.k.a. Boolean) using “and/or” commands.

To add or subtract compound criteria, use the 
double arrow buttons in the upper-right corner 
of the dialog.

Results of your search are defi ned by the pull-
down menu in the lower-left corner of the Find 
dialog box. Find next will highlight the fi rst fi le that 
meets your search criteria. Select all will select fi les 
that meet your criteria. Show all will hide all fi les in 
the catalog that do not meet your criteria. Show 
all in a new catalog will place all matching results 
in new catalog. 

Searches can be saved for later recall in the 
drop-down menu in the upper-right corner of 
the Find dialog box.
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Search Box: Type the word or words in this fi eld and 
press the Return or Enter key. Results are presented in 
the active catalog view. 

Save searches 
for easy access 
in this drop-
down menu. 

Add or Subtract search criteria using these arrows.Find items: Defi ne the catalogs you wish to search.

Results: Defi ne how you want search results presented.

Boolean 
commands 
for compound 
searches.
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Sorting by fi le attributes
and annotations
Field Finder - Organize Panel: To fi nd fi les that 
match an attribute (date, media format) or anno-
tation (events, locations, etc.), click on the fi eld 
label in the Field Finder of the Organize Panel and 
the corresponding fi les appear in the active view.  
To open the Organize Panel, use CMD-5.

Use the Field Organizer drop-down menu to 
show/hide various media attributes and annota-
tions that you can use for sorting functions.

Quick Sort (Toolbar) lets you view and sort 
fi les by more than 20 attributes and annotations. 
iView MediaPro can also sort fi les randomly for 
slide show viewing. The Default option returns 
the organization of fi les to the last saved version 
of the catalog.

Show Labelled  (Find menu): Show only those 
fi les associated with a particular color label, or 
those fi les without labels, in your catalog. Labelled 
fi les can also be sorted by using the Search Labels 

drop-down menu of the toolbar. This same option 
is available in the Slide Show Controller.

List View: To sort the catalog according to 
a various attributes and annotations click the 
corresponding header bar above the list area. To 
invert the sort order, click the arrow on the far left 
of the information bar. Use View Options (Window 
menu, CMD-J) to show/hide media attributes and 
annotations in the header bar.
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Field Finder: Find fi les that match a media attribute (date, media format) or annotation fi eld (events, locations, etc.).

Field Organizer 
drop-down menu: 
Use this menu to 
show/hide various 
media attributes and 
annotations that you 
can use for sorting 
functions.

A check mark 
indicates that this 
fi eld is active in the 
fi eld fi nder. Select it 
again in this menu to 
deactivate it.

Click on a fi eld label in the Field Finder and the 
corresponding fi les appear in the active view. 

Indicates the number 
of media in the 
catalog associated 
with the attribute or 
annotation.

Labelled fi les can be sorted by using the Search Labels 
drop-down menu of the toolbar. This same option is 
available in the Slide Show Controller.

Click to invert sort order of media in catalog (CMD-;)
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Sorting by sets and folders
Sort by a set: Click on the set or container name 
in the  Organize Panel.  This displays the items of 
the selected set in the active view, hiding all other 
fi les in the catalog. 

Sort by folders: Find fi les by their location on 
your computer or removable disks, by clicking on 
the appropriate folder in the Folders Panel. The 
corresponding fi les will appear in the active view. 
To open the Folders Panel, use CMD-6.

Alternatively, you can display a group of sets 
or folders by clicking each folder or set name and 
holding down the Command key. 

Restoring the catalog view
After you have found your fi les, use Show All in the 
Find menu (CMD-E) to reveal all the hidden fi les in 
your catalog. You can also use the Show All Items 
icon in your toolbar to show all fi les.

Finding original fi les 
Show Media File (Toolbar) reveals the location 

of the selected media item(s) on the desktop. 
Show Last Import (Find menu) reveals the 

most recent imported fi les. 
Show Duplicates (Find menu) searches and 

compares similar or duplicate fi les, allowing you 
to set the level of similarity (tight or loose). Addi-
tional options: Ignore brightness is good if you want 
to exclude image brightness quality. Compare items 
with similar names is useful for imports of images 
from digital cameras that reuse fi le names, which 
can confl ict with a previous import. 

Duplicate results are presented in your catalog, 
hiding all other fi les. This allows you to identify 
and compare two fi les, side by side, and rename or 
discard the fi les. Afterward, use Show All in the Find 
menu (CMD-E) to reveal hidden fi les.

Find Missing Items (Find menu) searches to 
fi nd broken links to media fi les and highlights all 
unmounted or missing items in the catalog. You 
can then remove the item from the catalog or 
search for the missing fi le in a specifi c directory. 

MediaPro stores the path of the original fi le and 

can detect if the fi le has moved in a relative path. 
If the fi le name has changed, the fi le or folder has 
moved, or the fi le, folder or volume is no longer 
mounted, the full size image in Media View will 
no longer be available and an error message (File 
Missing -43) appears in the top right hand corner 
of the information bar. 

The thumbnail and annotation data is kept in 
the catalog but the path to the full size image, 
movie, or sound is no longer correct. To rectify this, 
you can use the Reset Path dialog (Find menu) to 
amend the fi le paths. 

Reset Path  (Find menu) allows you to reassign 
or modify the path, for one or more items. Using 
the dialog, navigate to and select the folder or 
directory where the fi le(s) now reside. MediaPro 
will display each fi le in a window for you to 
confi rm each fi le’s path restoration. If you have a 
group of all fi les, and you are certain that all the 
new paths are correct, you can use the Accept 
All button in to avoid having to confi rm each to 
new path. This feature is useful when you know 
you have repositioned a folder or disc with items 
referenced in the catalog. 
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Reset Path dialog, once results have been found. 

Restoring the catalog: After you sort a catalog, use the 
Show All Items icon in your toolbar to reveal hidden fi les.
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iView MediaPro enables you to view or project a 
slide show presentation with your photographs, 
movies and audio soundtracks. 

Slide Show Basics
• To start, click the Slide Show button in the 
toolbar (  ) or press CMD-R.

• During the slide show, click the Escape key or 
double-click to exit. 

• The slide show is controlled via the fl oating 
controller, which you can display or hide by 
pressing the Enter or Return key. 
Audio: MediaPro slide shows can contain a 

single (background) audio channel. Sound items 
included in a catalog are always queued into the 
audio channel. If you place an audio fi le at the 
beginning of a slide show of images, it plays dur-
ing the presentation.

Video: MediaPro slide shows can display  up to 
16 video channels (max). All media types (includ-
ing images, movies or movies with sound) are 
played in one or more video channels depend-
ing on your grid selection.

Grids are the arrangement of video channels, 
in full-screen, quarter-screen or a variety of other 
options. Unless you are using a fast computer, using 
the slide show with more than one video track will 
place considerable strain on your machine and 
degrade playback. Experiment with Half or Quar-
ter video channel grids fi rst before choosing more 
complex grids. 

You can change grids during the slide show by 
using the “d” or Shift+d keyboard shortcuts. You 
can also use the Grid drop-down menu of the slide 
show controller. There might be a slight delay when 
changing grids while MediaPro loads the media.

Timing: MediaPro offers the option to adjust 
the amount of time images appear on screen. 
Movies will appear on screen for the duration of 
the video. To adjust timing of images (in seconds), 
use the up/down arrows next to the green num-
ber on the right hand side of the controller.

 Transitions: MediaPro offers several options to 
adjust the transition effect between images. There 
are 10 different transition effects, such as Cross 
Fade, Barn Horizontal and Radial wipes, as well as 
a Random effect option.  

Effects defi ned in the Transitions drop-down 
menu of the slide show controller apply globally 
to all images of the slide show. 

Size of Media: You can enlarge or reduce the 
scale of your images with the Zoom In/Out keyboard 
shortcuts (+ and –). This setting will apply globally 
to all images of the slide show. You can also use the 
Scale drop-down menu of the slide show controller 
to adjust the size of media on screen.

Slide Show Controller 
This palette allows you to adjust the presentation 
options. This is useful for running presentations on 
a second screen or projector. 

If you use multiple monitors, position your 
catalog inside the monitor you want to use for 
the slide show. You can start the presentation on 
your second monitor, and keep the Controller on 
your fi rst to guide the presentation. 

If you are not using two monitors, displaying 
the slide show controller on top of the slide show 
stage will impair ideal viewing.
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Slide Shows

Slide Show controller: Use Enter or Return key to hide 
or show controller.

Control Options Transitions

Exit Back Play
Pause

Forward Scale

Adjust timing
(in seconds)

Adjust 
volume

File shown |
Total fi les in catalog

Grid
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Playback Settings
• Interactive: Using this option enables you to 
use the forward/backward arrows of your key-
board to manually advance or go back in your 
presentation. The up/down arrows work the 
same as forward/backward arrows. 

• Continuous: This is the default option of 
MediaPro slide shows. Images will appear 
on screen for the duration of the global tim-
ing, then automatically advance to the next 
image. Movies appear on screen for the dura-
tion of video, then automatically advance. 
You can use the spacebar to Pause/Play a 
slide show in Continuous mode. As well, the 
forward/backward arrows will manually over-
ride the pace of your presentation.
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Slide Show controller: Files panel. Slide Show controller: Info panel.

Use arrows to advance through layers of fi le information. 
This area shows all available annotations, metadata and 
captions. The amount of information varies for each fi le, 
depending on the metadata that is stored within it. 

Use this arrow to show panels of the controller.

Each media fi le can have 
individual Timing, Transition, 
Grid and Scale settings. To 
defi ne one of these settings, 
select the fi le in the list and 
make a selection from a 
drop-down menu in any of 
the four squares to the right 
of the fi le name (See fi gure 
below).

Use arrows to adjust Timing Transition

GridScale

Timing

Color Label: Click picture to assign label

Show All Items 
restores the slide 
show list to show all 
items. Appears after 
sorting using labels. 

Show Labelled Items 
will display media 
fi les marked with a 
particular color label.
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• Random: MediaPro will randomly choose 
images and movies to present on screen.

Stage Settings
• Set background color: Change the background 
color of slide shows. Black is set as the default.

• Draw margin between media will add a few 
pixels of background color to help sepa-
rate items from each other in multi-fi le grid 
arrangements. 

Other Options
• Play voice annotation will play an attached 
voice annotation whenever a media item is 
loaded. 

• Play sound from all movies plays all the avail-
able movie audio tracks simultaneously.  This 
option is only useful when you intend to play 
multiple movies in a grid arrangement. If this 
feature is disabled, MediaPro plays only the 
background sound channel, as well as the 
active movie soundtrack. 

Slide Show Options
The setup features and options can be set prior 
to running the slide show, using the Slide Show 
Options dialog in the Make menu. This dialog box, 
as well as the Controller, allows you to set the fol-
lowing options: 

General Options
• Duration is the fl ip speed in seconds for each 
slide. (In the Controller, the duration can be 
adjusted using the up and down arrows on 
the top right hand corner of the window.) The 
duration applies only when the slide show is 
run in non-interactive mode. Note that mov-
ies and sounds default to their own duration. 
The duration can also be over-ridden by tim-
ings set for individual media items.

• Color: Change the background color of slide 
shows. Black is set as the default.

• Transition: The current version of MediaPro 
offers a basic set of QuickTime effects which 
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Slide Show controller: Text panel.

Text options enable you to display a variety of media 
information beneath the image.

Choose text color, size and alignment by clicking on the 
respective buttons.

When the Title annotation is not available, MediaPro 
will show the File Name. 
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can be used during slide show media transi-
tions. The duration of the transition effects 
(1 second) is currently fi xed. This setting will 
effect all media items, unless individually 
defi ned (see Timings). 

• Media Scaling lets you control the scale or size 
of media items. You can set this option before 
or during an active slide show. 

• Stage Grid: The slide show can run the stan-
dard full screen or you can divide the screen 
into several video channels, from half, quarter, 
sixteenth, to a range of different cell arrange-
ments. 

Playback Options
• Interactive (or click mode), allows the user to 
click the mouse, use the space bar or arrow 
keys to advance to the next media item in the 
slide show. In this mode, the pause button 
changes to a mouse icon. Switch this option 
off to run the slide show using timers. 

• Continuous mode runs slide show presenta-
tions in a loop, restarting automatically from 
the beginning of the catalog when the slide 
show has fi nished. This mode is useful for 
kiosk or exhibition presentations. 

• Random: MediaPro will randomly choose 
images and movies to present on screen.

Other Options
• Margin between grid cells will add a few pixels 
of background color to help separate items 
from each other in multi-fi le grid arrange-
ments. 

• Play voice annotation will play an attached 
voice annotation whenever a media item is 
loaded. 

• Play sound from all movies plays all the avail-
able movie audio tracks simultaneously.  This 
option is only useful when you intend to play 
multiple movies in a grid arrangement. If this 
feature is disabled, MediaPro plays only the 
background sound channel, as well as the 
active movie soundtrack. 

• Fade In  fades the start and end of the slide 
show. 

• Show controller will display the slide show 
controller during the slide show. Use the Esc 
or Return keys to hide the controller.

Keyboard Shortcuts
MediaPro 2 has added a complete set of shortcuts 
for keyboard navigation of slide shows. See page 
80 for a list of these shortcuts.
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Slide Show Example: Uses a Quarter grid, displays 
Photo Info and Draws margin between media. Ideal for 
photographers to compare results.

Slide Show Options: Shift+CMD+R
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Save a Slide Show as 
a QuickTime Movie
MediaPro lets you save the slide show (full-screen 
grid only) as a QuickTime movie, so you can dis-
tribute your movie fi le without the need to include 
the application itself. 

Slide shows can be saved with any grid, as well 
as generic and individual transition effects and 
timings. A QuickTime movie can be played using 
Apple’s QuickTime Player on both Mac and Win-
dows computers. 

To create a QuickTime movie slide show, 
choose Save Slide Show as Movie... in the Make 
menu. In this dialog, you can defi ne the movie 
dimensions or choose from a pre-defi ned set of 
industry standard sizes. 

To control the background color, global slide 
duration and transition effect, use the Slide Show 
Options dialog (Make menu). To setup transition 
effects and timing, also use the Slide Show Options 
dialog (Make menu). 

MediaPro offers a range of playback options 
when running QuickTime Player. For instance, 
click the checkbox to switch on auto-start and full 
screen mode options to have your movie played 

back in full-screen mode automatically, when you 
double-click on the movie fi le on the desktop. 

If you select Include chapter track, QuickTime 
will display each fi le name in a pull-down menu 
of the movie (see fi gure above).
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These options will embed information that will instruct 
the QuickTime Player how to handle the movie.

Dimensions 
drop-down 
menu allows 
you to choose 
from a list of 
pre-defi ned 
set of industry 
standard sizes.

Exported QuickTime Slide Show presentation: If you 
choose to include the chapter track, QuickTime places 
fi le name and places it in a pull-down menu. 

Movie Presentation Options: In the Make menu

Use this pull-down menu to defi ne the level of 
compression applied to the exported movie.
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Adding a soundtrack 
to a slide show
Use the following instructions to add a background 
soundtrack to your slide shows:
1. Create a catalog of images and movies, then 

organize the in the order you want them to 
appear in the slide show.

2. Place an audio fi le (MP3, AIFF, etc) as the very 
fi rst fi le in the catalog. 

3. Make sure the audio fi le is selected and then 
start your slide show. The music will continue 
to play throughout the slide show.

4. When you quit the slide show (ESC key), the 
song will automatically fade out.

5. If at any point, you want the slide show to 
switch to a different song, just place an audio 
fi le at that point, and MediaPro will automati-
cally fade one song out, and fade in the new 
song. 

6. If you have Play sound from all movies selected 
(Slide Show Options Make menu), MediaPro 
will also play movies with sound over the 
background soundtrack. It plays the movie at 
current volume, and makes the soundtrack 
softer so that the movie sound is clear.

Making slide shows faster
In most cases, two factors affect the speed of 
slides shows: grids and media fi le size.

Grids: Unless you are using a fast computer, 
using the slide show with more than one video 
track will place considerable strain on your 
machine and degrade playback. Experiment with 
Half and Quarter video channel grids fi rst before 
choosing more complex grids.

File Size: On slower computers, a slide show 
of 20 MB image fi les will run much slower than 
a slide show with 1 MB image fi les. What slows 
MediaPro down is not necessarily the fi le size, but 
the actual dimensions of the media. Usually with 
larger dimensions, MediaPro has to dynamically 
shrink the image to fi t the screen. If the image is 
the same shape as the screen (4:3 proportion) this 
delay isn’t too noticeable. But for portrait images 
(vertical), this delay can be a few seconds.

Super fast slide shows: A solution to the speed 
and audio skipping issues is to create a temporary 
copy of your images that are optimized for the 
fastest on screen display. You can do this by using 
the batch Convert Image Files... in the Make menu. 
Here are the parameters that help:

• Size: Match your screen resolution (for exam-
ple, 1024x768). That way MediaPro won’t have 
to resize the image.

• Setting: Match your monitor’s color depth 
(Thousands or Millions). This will save proces-
sor intensity.

• Resoultion: 72 dpi, same as your screen
• File format: Select an uncompressed format, 
such as Bitmap (BMP) or PICT instead of 
JPEG. This way the image fi le won’t have to 
be decompressed on the fl y, during the slide 
show.
Create a new catalog with the converted imag-

es and your slide show will be amazingly fast.
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Export Features

iView MediaPro will export and convert your media 
fi les in a variety of ways, by selecting options from 
the Make menu.

HTML Gallery 
With this export function, you can output a 
catalog of images and movies as a web site that 
includes both an Index page and a linked Media 
page for every item in the catalog.

Photographers, illustrators and designers can 
use this option to quickly create a portfolio web 
site of their work. QuickTime movies can also be 
exported to HTML galleries.

An HTML gallery looks similar to the catalog in 
iView MediaPro. It contains an index of thumb-
nails which, when clicked in a web browser, will 
take you to a large view of the image.

iView MediaPro offers you two options when 
you create HTML galleries:
1. You can use a default theme to create your 

web site based on the View Options of the 
Thumbnail and Media Views in your catalog. 
Or you may use any of the pre-defi ned visual 
themes provided with the application.

2. You may use your own Themes, which can be 
created before exporting and saved inside 
the user-defi ned Plug-Ins - HTML Templates 
folder (see page 2). iView MediaPro uses a 
different template for the index and media 
views of your gallery, and offers a rich vocabu-
lary that can be used to extract catalog infor-
mation (fi elds, thumbnails, etc.), as well as a  
high-level tags for navigation, date, time, etc.  

Create a Gallery 
1. Launch an iView MediaPro catalog of pho-

tos, illustrations, movies or any media fi le that 
can be distributed on the web. Under the 
Make menu, select HTML Gallery.

2. Choose a Theme: In this dialog, you can defi ne 
what your web gallery will look like. 
Site Title: This text will appear at the top of all 
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Gallery Options: The Theme panel, with Default chosen

Gallery Options: The Theme panel, with the Aqua 
theme selected. Themes have pre-defi ned table 
grids, thumbnails and media sizes. However, you can 
customize to your liking by modifying these fi elds.
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Index Page

Media Page

Tip: To reduce loading of your 
web pages, try to include less 
than 25 images on a single 
index page.  As well, you might 
try a smaller thumbnail size.

File Name

Thumbnail Table: The number 
of thumbnails (across and 
down) that appear on an HTML 
Index page.

Index page links: The number 
of thumbnails (across and 
down) that appear on an HTML 
Index page.

Site Title

In some themes, the gallery’s 
creation date is added 
automatically.

Media size  is defi ned by the 
theme chosen. Each theme’s 
media page template has HTML 
Engine Directives that defi ne 
media image size.

Media info: Any captions and 
associated metadata tags 
(such as EXIF or IPTC fi elds) can 
appear on Media theme pages.

Navigation: On Media pages, 
the web site viewer can advance 
through the gallery using the 
previous/next links, or they can 
return to the Index page of the 
gallery. In some templates, icons 
represent these links.

Thumbnails: All images are 
automatically hyperlinked to 
their respective media pages.
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pages in your gallery. If you don’t want a title, 
leave this fi eld blank. 
Thumbnail Table: Customize how many 
thumbnails, across and down, will appear on 
the Index page in a gallery.  
Theme: Choose from a selection of preset 
themes or use Default to create your web site 
based on the View Options of the Thumbnail 
and Media Views in your catalog. If you use 
default, make sure to choose the desired 
table grid,  Thumbnail and Media size. All 
other themes have pre-defi ned sizes and 
grids that are designed for optimal output. 
However, those settings can be adjusted to 
your liking.

3.  Adjust your Settings
HTML Extension: Defi nes the suffi x of fi le 
name (htm, html, shtml, asp, php, xml)
Text Encoding: Change for language types 
(Western-Latin 1, Japanese)
Output: Use numbers for HTML fi lenames uses 
a numerical increment (1,2,3...) for HTML fi le-
names instead of the media fi lename. Treat 
captions as raw HTML enables you to use 
HTML code, such as <b></b>, in the Caption 
annotation fi eld.
JPEG Quality: Choose the level of compression 
applied to thumbnails and media images.
Embed IPTC annotations: MediaPro will 
synchronize the IPTC annotations with the 
exported image.
Movies: Adjust the properties of QuickTime 
movies on Media pages. Auto-play will auto-
matically play a movie, once it’s loaded in a 
browser;  Continuous will make the movie 
play in a loop; Display QuickTime Controller 
toggles the standard QuickTime controls for a 
movie on and off.

4. Create: After defi ning your settings, click 
on Create. The amount of time it takes for 
iView MediaPro to create a gallery can vary 
depending on the number of images, their 
original size and the export size. The gallery 
will launch in a browser after export.
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Gallery Options: The Settings panel

For repeat use of your settings, 
save your options using the 
Options menu. This is useful 
if you have alternate settings 
using the same theme. Saved 
options can be recalled at any 
time and can be incorporated 
in AppleScripts. 
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<HTML>
 <HEAD>
 <TITLE>(iView:Catalog)</TITLE>
</HEAD>
 <BODY> 
  <P>Simple Media Template</P>
  <P>Image:</P>
  <P>(iView:Media)</P>
  <P>File name:</P>
  <P>(iView:Filename)</P>
 </BODY>
</HTML>

HTML Tips
• To reduce the loading time of your Index 

pages: Include less than 25 images on a single 
index page.  As well, you might try a small size 
thumbnail (such as 96 pixels), with low resolu-
tion settings.  

• To reduce the loading time of your Media 
pages: Try a smaller size media export (such 
as 480x320 pixels), or increase the amount of 
JPEG compression in the Settings panel.  

• To use a Cascading Style Sheet (CSS) with 
a theme: Using embedded style sheets will 
work fi ne with MediaPro themes. In order to 
use a linked style sheet, place the CSS fi le in 
your theme’s Assets folder. This way, the style 
sheet will be exported as a related asset of 
your gallery. Because MediaPro uses HTML 
tables to create Index pages, CSS and XHTML 
cannot be used to control the positioning of 
Thumbnail tables. If your site already has a 
stylesheet that you would like to use, make 
sure and write a complete URL to the existing 
CSS in your theme.

• Defi ning the fi le creator of exported gal-
lery pages: In version 2.0, an HTML fi le’s 
creator code is defi ned by the creator code of 
a theme’s template. For example, if you cre-
ated a theme template using Dreamweaver, 
that would be the creator of the exported 
pages. The fi le creator for images is always 
QuickTime.

Creating Themes & Templates
iView MediaPro 2 introduces themes to help orga-
nize HTML export templates. A theme is simply 
a folder containing Index and Media HTML tem-
plate. By storing both templates in one folder it is 
much simpler to share a new gallery design with 
others. A theme folder also typically contains an 
Assets folder for related HTML graphics and an 
image used as a preview of the theme in the 
HTML export dialog. 

MediaPro templates are normal HTML pages, 
that may contain one or more fi eld phrases that 

get replaced with MediaPro content during the 
export process.The example above is a simple 
HTML template which contains three MediaPro 
fi eld phrases: (iView:Catalog), (iView:Media) and 
(iView:Filename). 

During export, all three phrases get replaced 
by the catalog name, the media image and the 
image fi le name respectively.

To learn more about creating themes and tem-
plates, refer to the About Templates document in 
the application’s Documentation folder.

A good way to learn is to make a copy of an 
existing template, rename it, and modify different 
fi elds or the design.  Modifying theme templates 
requires a modest knowledge of HTML. You can 
learn more about HTML from a basic HTML hand-
book or by reading tutorials on sites like CNet’s 
Builder or Wired’s Webmonkey.

New template features in version 2.0: 
• HTML Engine Directives: The size of images 
on Index and Media pages are now controlled 
in the theme using these new tags. Thumbnail 
tables are also controlled by directives. When 
a theme is selected in the HTML export dialog, 
MediaPro will populate the appropriate fi elds 
with the directive’s values.

• New tags: Phrases have been added to 
include an additional image directory which 
will contain a copy of the original images. 
Phrases have also been added to export a 
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Template: Example of a basic Media template
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Create a cross-platform CD
One way to create a catalog of images that is 
compatible with most operating systems (Win-
dows, Unix,  MacOS), is to burn an exported HTML 
gallery onto a CD or DVD-ROM disc. Here is how 
to do it:
1. Create your catalog as usual, add the fi les, 

set the layout, add your keyword, annotations 
and captions. Since some computer platforms 
do not accept long fi le names, you must 
shorten all your fi le names to 8 characters or 
less. You can easily do this using the Batch 
Rename command in the Action menu. Use 
that same command to ensure that you have 
the proper fi le name extensions on all images 
or movies, as some platforms require exten-
sions. Remember, renaming fi les cannot be 
undone, so you might want to make a backup 
of your media before you rename them for 
this HTML gallery.

2. Export an HTML Gallery, using a MediaPro 
pre-defi ned theme or one that you created. 
HTML can be further customized with an 
HTML editor after export.  In this step, you will 
want to choose the HTML Extension “.htm” in 
the Settings pane. This will work on all plat-
forms. All links inside the gallery pages must 
be relative (e.g. .../img/hello.jpg) in order for 
them to work on a CD.

3. Burn your gallery fi les onto the CD: In order 
for your CD to be cross-platform compatible, 
you must burn the CD in the ISO 9660 format.

4. Extra: You can use the Print Template called 
CD Jewel Case to print a cover for the CD you 
just created.
Another way to create a cross-platform CD or 

DVD of media for use on Mac and Windows plat-
forms is to burn your media, the catalog and copy 
of iView Catalog Reader on the CD or DVD. Using 
this royalty-free software, you can distribute and 
share your iView catalogs with non-iView users 
at no cost or restriction. See page 62 for more 
information on Catalog Reader.

<!-- iView HTML Engine Directives 
(iView:InMediaWidth 800) 
(iView:InMediaHeight 600) 
--> 

group of all IPTC fi elds or all EXIF fi elds on 
Media pages.

• New structure for Theme folders: Each 
theme has its own folder which contains 
the Index and Media templates as well as 
an Assets folder.  A preview JPEG of the tem-
plate (to be displayed in the export dialog) is 
optional.

• Store your themes in the user-defi ned Plug-
ins folder (see page 2) to ensure that they are 
not lost during upgrade. 
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Directives: A template that has media width and height 
directives (above) will populate the appropriate fi elds 
when this theme is selected in the HTML export dialog. 
You can still make changes to the fi nal export from this 
dialog without having to go back into the template.

Themes: Each theme should contain an Index and 
Media template, as well as an Assets folder. Custom 
created themes should be stored in the user-defi ned 
Plug-ins folder. On OS X, it is typically at: 
~User/Library/Application Support/iView/Plug-ins
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The text table function allows you to save media 
properties and annotation fi elds in text fi les and 
import them in 3rd-party database or spread-
sheet applications. You can save the text as a tab 
or comma-delimited text. 

You can also export your data using the 
Merge option, in order to create personalized 
documents like form letters. In Microsoft Word, 

for example, you can combine variable data (like 
media names, or properties) in a merge fi les with 
text in a main document. The Merge option is 
particularly useful when importing information 
in FileMaker Pro since it auto-detects fi elds to 
place imported data. 

For repeat use, save your options using the 
Options menu. Saved options can be incorporated 
in AppleScripts. 

Text Table Options 
is accessed by choosing 
Text Table in the Make 
menu.  Use the yellow 
arrows to add, remove or 
reorder desired fi elds.

For repeat use of your settings, save your 
options using the Options menu. Saved 
options can be recalled at any time and can 
be incorporated in AppleScripts. This feature 
is standard to MediaPro Export functions.

An example of an exported text table that has been imported in Microsoft Excel™.

Format options of the 
exported text fi le.

Use these Up and 
Down arrows to set 
the order of exported 
fi elds in the text table.

Use these arrows to 
add or remove fi elds 
from the exported 
text table. Double 
arrows will Add All or 
Remove All fi elds.
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Contact Sheet 
This function creates a contact sheet of all visible 
thumbnails in your catalog. You can adjust the size, 
resolution and format of the fi le to be created. 

iView MediaPro automatically calculates the 
number of cells that can fi t in the designated con-
tact sheet size, taking into account the size of your 
thumbnails and the number of fi elds displayed in 

the Thumbnail View. The layout style of Thumb-
nail View, fonts and colors of the thumbnail view 
are applied. To control these settings, go to View 
Options (CMD-J) in the Thumbnail View to adjust 
the appearance to your particular needs. 

A contact sheet can be further modifi ed or 
printed using a third-party image editing appli-
cations, such as Adobe Photoshop.

Supported format 
options of the exported 
contact sheet fi le.

TIP: To output a 
contact sheet that 
is 8.5 x 11, enter 612 
pixels for width and 
792 for height.

This dialog box is 
common to other export 
functions of MediaPro. 
Simply choose the 
quality of the exported 
contact sheet, or choose 
a target fi le size for 
MediaPro to produce. 
This dialog is contextual 
to the fi le format.

Exported contact sheets 
will inherit the visual 
appearance and displayed 
fi elds of the Thumbnail 
View. To alter the 
appearance of a contact 
sheet, you must change 
the View Options of the 
Thumbnail View (CMD-J).

TIP: You can create a 
catalog of contact sheets 
output by MediaPro. 
This is useful method of 
cataloging catalogs. 

If you have more thumbnails than appear on the Contact Sheet you 
have defi ned, MediaPro will output as many pages necessary to 
completely export the catalog. As you adjust the size of the Contact 
Sheet, the number of exported pages is adjusted. The number of 
thumbnails that appear on each page is defi ned by the thumbnail 
size in catalog Thumbnail View. 
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The File Conversion options are useful for single 
fi le or batch conversions. Select one or more 
media items and choose the appropriate option 
to convert images, animations, or sounds. 

Image conversion will convert images, as well 
as poster frames from animations into a new for-
mat such as JPEG, TIFF, etc. Sound conversions will 
convert sound fi les as well as sound tracks from 

selected movies. 
Note that existing metadata such as EXIF or 

IPTC annotations and associations with sets or 
other annotation fi elds will no longer exist in the 
converted media fi les.

For frequent uses of this feature, you can save 
your options using the Options menu. Saved 
options can be recalled at any time and can be 
incorporated in AppleScripts.

Image conversion
will convert images, as 
well as poster frames 
from animations into a 
new format. To convert 
to other formats, you 
will need to use a 3rd 
party application. 

Movie conversion
will convert movies and 
animations into a new 
format. If you convert to 
DV Stream, the fi le can 
be imported into Apple’s 
iMovie for additional 
editing. 

Sound conversion will 
convert sound fi les as 
well as sound tracks 
from selected movies

For a more detailed explanation of the 
fi le format conversions, please refer to 
the QuickTime Help fi le in your Apple 
Help Center (Help Menu).
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Other Export Features
Export Thumbnails: (Make menu) This new 
feature saves thumbnails of a catalog as a sepa-
rate fi le (in the .PICT format). The dimensions of 
the extracted fi le will match the dimensions of 
the thumbnail defi ned in Thumbnail View. This 
applies to a single fi le or a group of selected fi les. 
If no fi les are selected, the pop-up dialog offers 
the option to export thumbnails for all fi les the 
catalog. 

Export Voice Annotations: (Make menu) This 
feature saves an embedded audio annotation as 
a separate fi le (in the .AIFF format).  This applies to 
a single fi le or a group of selected fi les. If no fi les 
are selected, the pop-up dialog offers the option 
export voice annotations for all fi les the catalog. 
In previous versions of MediaPro, this function 
was in the Annotations submenu of the Action 
menu.

Backup/CD-ROM
This feature (Make menu) enables you to prepare 
CDs and DVDs for burning using Apple’s built-in 
disc burning technology. Backup is also ideal for 
archiving digital fi les onto disk partitions, remov-
able disks (e.g. Zip) or hard drives on a network. 

MediaPro automatically scans your computer 
for available hard drives, partitions and removable 
media, such as CD, DVDs and Zip drives. It places 
available locations for backup in the Destination 
pull-down menu. 

When backing up fi les to a CD or DVD that 
will be burned with Apple’s built-in Disc Burning 
technology, the CD is named on the desktop after 
it has been inserted into disk bay.

Additional options enable you to backup all 
media fi les, only the media fi les visible in the cata-
log (e.g. showing a set in the active view). You can 
also include the folder structure of your original 
media, as well as include a copy of the MediaPro 
catalog with your backup. Catalogs must be saved 
before the backup process can begin. 

To backup your media, chose your options, 

then click the Backup button.  MediaPro may ask 
you to save the catalog before burning.

Before backing up fi les to a CD or DVD, you 
might also consider placing a copy the iView 
Catalog Reader application on your removable 
media. Using this royalty-free software, you can 
distribute and share your iView catalogs with 
non-iView users at no cost or restriction. 

iView Catalog Reader is included in the iView 
MediaPro application folder. Simply copy it your 
removable media before burning.

Alternative Backup: Copy to Folder
The Backup function does not provide the option 
of choosing a particular folder. MediaPro’s Copy to 
Folder feature will do this. 

Select a fi le, group of fi les, or all fi les in the cata-
log, then chose Copy to Folder in the Action menu. 
Then navigate to and select the folder to place a 
copy of your fi les. 

Copy to Folder does not affect the fi les in your 
current catalog. It simply makes a copy of the fi le 
in a new location. MediaPro will always ask you 
to confi rm before replacing existing fi les of the 
same name.
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Backup/CD-ROM dialog: MediaPro automatically scans 
your computer for available hard drives, partitions and 
removable media. 
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Helper Applications
When browsing or viewing fi les in a MediaPro 
catalog, it’s likely that you may want to act upon 
a fi le in some way outside of the feature set that 
MediaPro provides – such as fi le editing or com-
pression. To assist you, there is a function called 
Open With. 

The way it works is simple: Select any fi le (or 
group of fi les) in the catalog and open it with a 
“Helper” application. Using Helper applications 
keeps you from having to launch an application, 
navigate through the Finder and locate the fi le. 

Helpers are defi ned in the Defi ne Helper Appli-
cations dialog box (see fi gure right). This panel will 
let you choose media editors, utilities or viewers 
so that you may quickly access them via the pull-
down menu in the  application toolbar or through 
a contextual menu. 

How to add a Helper:  Go to the Defi ne Helper 
Applications dialog box, and click the Add button. 
Navigate to the application through the Finder 
and select it.  When fi rst launched, iView MediaPro 
will automatically scan your computer for Helpers, 
but you may want to add or remove some later.

The possibilities are limitless for using Helper 
applications in your workfl ow. Here are some 
ways Helpers can assist you:

Email: You can add any fi le, direct from MediaPro,  
as an attachment to an email. To do this select the 
fi le, then choose a mail client in the Helper appli-
cation drop-down and the fi le will automatically 
open as an attachment to a new email. Results will 
vary depending on your email client and operat-
ing system.

Image editing: Assign applications such as 
Adobe Photoshop or Graphic Converter as Helpers 
for editing photos. When browsing a MediaPro cat-
alog with images, you can quickly access an image 
that you want to edit, open it in the application, 
then save it. When you get back to your catalog, 
execute a Rebuild Thumbnail command (CMD-B) 
to see the change refl ected in the thumbnail.  

Edit anything:  The same technique for editing 
images can be applied to just about anything 
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Defi ne Helper Applications: To access this dialog, 
choose Set up Menu in the toolbar’s drop-down menu 
(below) or in a contextual menu.

Accessing Helpers
After selecting the fi le, you can 
execute an Open  With command two 
ways: In the toolbar’s icon pull-down 
menu (top), or through a contextual 
menu (below). Press Control-Click to 
access a  contextual menu.
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- desktop publishing fi les such as InDesign and 
Quark; graphics fi les such as Freehand or Illustra-
tor; even audio, video and text fi les. Just assign the 
appropriate application for the fi le and execute 
the Open With command.

Compression and Packaging: Assign Aladdin 
Systems’ StuffIt, DropStuff or DropZip tools to 
compress or create self-expanding fi les for Mac 
and Windows.  This usage is excellent for packag-
ing a group of media fi les for email, backup and 
burning.

Previews and Players: While MediaPro is an 
excellent viewer for almost every fi le, you may 
want to view your fi les in another application 
such as the OS X Preview app, browsers such as 
Internet Explorer or the QuickTime player. If you 
use other players, such as iTunes or Audion, set 
them as Helpers. This will make it easy for you to 
add a particular MP3 to the iTunes database.

Font management: For OS 9 users, you can 
assign ATM Deluxe as a Helper for a quick, effi -
cient way to add fonts from a MediaPro catalog 
to ATM’s active Sets & Fonts window. This means 
that making any font active in your system only 
one click away. 

CD-Burning & Backup: Assign Roxio’s Toast 
Titanium CD and DVD-burning application as a 
Helper and add fi les to a new disc image ready 
for burning. Of course, this action is similar to, but 
not exactly the same as, iView MediaPro’s Backup 
command (see page 55).

Applets and Droplets:  Any AppleScript that 
has been saved as an executable is viewed by 
your operating system as an application. This is 
helpful for integrating droplets created by Adobe 
Photoshop or ImageReady into your workfl ow. A 
“Rotate 90 Left” Photoshop droplet or “Make JPEG 
(quality 60)” ImageReady compression droplet 
will save you quite a bit of time when used as an 
MediaPro Helper. 

Online Photo Printing Services:  While iView 
MediaPro does not have built-in functionality for 
ordering prints from an online photo service, it’s 
easy to make MediaPro work with photo services 

by using Helpers. Simply set the online photo ser-
vice software as an MediaPro helper application. 
Then “open” the images with this helper applica-
tion. For some photo service software, this may not 
work. In that case, you can select the images you 
want and drag-and-drop them from the MediaPro 
catalog to the Upload software. This also works 
well for use with Apple’s iPhoto software.
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Examples of droplets created by Adobe ImageReady, 
Photoshop and AppleScript Editor. Remember that any 
AppleScript applet, scriptlet or droplet,  is an application 
and can be defi ned in MediaPro as a Helper.

When you use OS 10.2’s Mail client as a Helper 
application, it automatically takes any selected fi le in an 
MediaPro catalog and opens it as an attachment. This is 
great for mailing photos to family and friends.
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iView Catalog Reader
This new software from iView allows you to dis-
tribute and share your iView catalogs with anyone 
at no cost or restriction.

iView Catalog Reader is free to download and 
distribute and works on both the Macintosh and 
Windows platform.

iView Catalog Reader will open catalogs written 
by iView Media 1.2, MediaPro 1.5 or MediaPro 2.0. 
It understands the full 120+ media fi le formats of 
MediaPro and includes a Slide Show function.

Burn iView Catalog Reader and your catalog to 
CD or DVD, send by email, or across a network to 
enable others to view your catalog.

You can choose whether you would like to 
include your original media with a catalog which 
you distribute. This lets you protect your digital 
assets from being copied while allowing others to 
view the List and Thumbnail Views. If you include 
original media this will allows a Catalog Reader 
user to access the media contained in a catalog.

iView Catalog Reader does not allow the viewer 
to make any alterations to your catalog or to cre-
ate new catalogs. You do not have to purchase 
iView MediaPro 2.0 to use iView Catalog Reader.

Protecting catalogs 
Once you have created a catalog for distribution 
with iView Catalog Reader, you might want to 
prevent others from viewing or accessing it. To 
set password protection for a catalog:
1.  Select Catalog Info from the File menu.
2.  Click on the Set Password button. This button is 

only available if you have saved your catalog.
3.  Type the password. Then save the catalog. 
4.  When opening the catalog in the future, you 

will be asked to provide the password before 
you can view the catalog’s contents. There is 
no way to recover a catalog password, so make 
sure to keep your passwords in a safe place. 

5.  To remove password protection, click on the 
Set Password button and delete the password 
in the fi eld. Then save your catalog, and pass-
word protection will be removed. 
Password protection on iView catalogs is not a 

high-level of encryption. For higher levels of secu-
rity, consider making an encrypted disk image 
using Apple’s Disk Copy or a tool like PGP.

Password protection applies to the catalog 
regardless of which iView application is open-
ing it.
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The iView Catalog Reader interface is slightly different from MediaPro. Details is the same as the Info panel, and 
is used for viewing annotations. Since this is a Reader application, annotations cannot be assigned in these fi elds. 
Catalog Index is the same as the Organize panel, and is used for fi nding and sorting media fi les.
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AppleScript
This menu displays AppleScripts that are inside 
MediaPro’s Plug-Ins - Scripts folder. Since MediaPro is 
AppleScript-Attachable, users can place additional 
scripts in this menu to access them during opera-
tion.  To add your scripts to this menu, place them  
inside the user-defi ned Plug-ins folder (see Page 2 
for location).

Annotate
• Copy Photo Data to Clipboard copies all EXIF 
photo metadata to clipboard.

• Import From PhotoDISC™ annotates images in 
your front catalog, using text fi les located in 
your PhotoDISC™ CD-ROM.

• Make Caption from Photo Data copies all EXIF 
photo metadata into the Caption fi eld. 

• Make Caption from Text Files searches for .txt 
fi les in the same folder as the original, and 
copies the contents into the caption fi eld.

• Make Caption from Text Lines opens a text fi le 
and uses each line of the fi le as the caption for 
the selected items.

• Make Event Date from Capture copies the EXIF 
Capture Date and puts it into the Event Date 
of the Annotations pane. 

• Make Keywords from Folders enables you 
to add keywords to media fi les from folder 
names. The pop-up dialog provides the 
option of defi ning the level of folders in the 
path you would like to use for keywords. 

• Make Product from EXIF Data copies the EXIF 
Maker and Model fi elds and puts them into 
the Product fi eld of the Annotations pane.
You can modify existing scripts or create and 

attach your own annotation scripts at any time. 
Simply write the script, then place it in the Plug-ins 
- Scripts - Annotate folder.
Desktop Picture

• Add (OS X and OS 9) sets the desktop picture 
of the main monitor to the selected fi le of the 
front catalog. 

• Remove (OS 9 only) discards the desktop pic-
ture of the main monitor.

Files
• Correct EXIF orientation will rotate the thumb-
nails of all selected items to correct any values 
of the Orientation fi eld written by your digital 
camera.

• Rename Using EXIF Date renames fi les using 
valid EXIF Capture Date fi eld. See Media Info 
Panel to view the Capture Date fi eld.

• Rename Using Text File opens a text fi le and 
uses each line of the fi le as the new name for 
the selected items.

• Set File Comment will save the Caption fi eld 
inside the fi le’s comment fi eld, visible in the 
Finder and the “Get Info” window of original 
fi les. 

• Set File Label will set the label of fi les in the 
Finder using label marking ID set in catalog.

• Set File Lock will lock the fi le in the Finder. 
Select

• All Landscape will select all images that are 
horizontal.

• All Portrait will select all images that are verti-
cal. Square images will not get selected by 
either AppleScript.

Web
• Visit iView Online will launch the home page 
of iView Multimedia’s web site in the default 
web browser.

Other
~Empty Trash will empty the trash in the Finder.

You can add your 
own AppleScripts 
to this menu by 
placing them in the 
user-defi ned Plug-ins 
folder (see Page 2 for 
the location of this 
folder).
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iView MediaPro now offers powerful image edit-
ing as well as calibration tools that can enhance 
colors, sharpness and brightness of your images. 

Image Editing 
The features of this tool apply only to image fi le 
formats (such as JPEG or TIFF) and will not work 
on movies or vector graphics. 

The Image Editor can be launched from the 
toolbar icon (  ), or by selecting Show Image Edi-
tor from the Window menu (CMD-Y).

In order to properly preview the fi lter effects 
of the Image Editor, MediaPro will automatically 
switch to Media View when a fi lter is selected.

To edit images, use the following process:
1. Choose a fi lter from the Image Editor palette 

by click on the fi lter name in the list. 
2. Make your edits in the pop-up fi lter dialog, 

the press OK. Apply as many fi lters to the image 
as necessary. Use the Revert button to discard all 
changes and reload the original image. Use the 
Undo button to remove the effects of the last 
fi lter applied.

3. Image modifi cations by any of the tools 
described in this section are not saved until you 
press the Save button in the Image Editor palette. 
The Save button launches a dialog to defi ne 
compression and fi le type settings. To overwrite 
the existing fi le simply press Save. This dialog also 
gives you the option of storing a backup copy of 
the original fi le in a folder of your choice, or in the 
Version Control folder.

It is important to note that saving image fi les 
using the Image Editor removes any embedded 
annotations (EXIF, IPTC, etc) that may have existed 
in the original fi le. 

The following pages describe how each of the 
Image Editor fi lters and tools work. You can use as 
many fi lters as you want before saving changes.

For instructions on how to use Version Control, 
see page 71.

Image Editing & Version Control
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Image Editor palette
To launch a fi lter or image editing tool, click on the 
name in the fi lter list. This will launch a dialog for this 
function. Press CMD-Y to show/hide palette.

Click on arrow to 
show/hide Version 
Control area.

Undo removes the effects 
of the last fi lter applied.

Revert reloads the image 
from the original.

Save launches a save dialog.
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Crop 
The Crop tool is used to reduce the visible area of an 
image. To begin cropping, click on the image and draw 
a box around the desired area. MediaPro greys out the 
area that will be cropped. Click the OK button to accept 
the crop.

Before accepting the crop, you can adjust the edges 
of the selection to fall exactly at the desired location. 
Simply place the cursor over one of the four sides 
and drag to the desired location. While adjusting the 
cropped area, you can review the coordinates of the 
crop in the Area fi elds. 

To constrain the proportions of a crop, check the 
Contrain box and enter the desired dimensions. This is 
useful for cropping an image for a specifi c print, screen 
or video sizes, such as 4x6 or 640x480. 

You can adjust the unit of dimension displayed in this 
dialog by selecting pixels, inches or centimeters in the 
Units pull-down menu.

Click Cancel to exit the Crop tool.
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The Units pull-
down menu 
controls the 
unit of measure: 
pixels, inches or 
centimeters. 

To move the 
cropped area, 
place your cursor 
in the active area, 
then click and drag 
the hand ( ). 

Resize the cropped 
area by clicking 
and dragging on 
any of the red 
control corners.  
When proportions 
are not constrained,  
you can pull on any 
side to alter the 
crop (see below).

Area defi nes 
the Left and 
Top edges of 
the cropped 
area in 
relationship 
to the original 
image. This is 
similar to X/Y 
coordinates 
used in other 
applications.

To begin 
cropping, click 
on the image 
and draw a 
box around the 
desired area. 
MediaPro grays 
out the area 
that will be 
cropped.

Width and height are the 
dimensions of the cropped area.  
The lock icon appears when 
proportions are constrained.

Check the Constrain box to lock the proportions of 
the cropped area. The drop-down menu in this area 
(  ) provides easy access to standard print, screen 
and video sizes.

When resizing a cropped area that is not constrained,  
dimensions can be adjusted by clicking and dragging 
on any side of the box.  You do not have to click exactly 
on the red control bars.
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Padding is the space created when you choose a target size that is wider or taller 
than existing image proportion. When you choose Enable Padding, MediaPro will 
fi ll in the extra space with a color of your choice (see above). If padding is not 
enabled, MediaPro will resize the image according the Scaling Mode. This usually 
scales the image to fi t the width or height. For example, without padding the 
horizontal image above would be output to match the width at 500x375. 

Resize 
The Resize tool is used to reduce 
the size of an image.  This tool 
works similarly to MediaPro’s 
batch fi le conversion utility, but 
includes some options for fi ner 
adjustment.

To resize an image, defi ne the 
new width and height in the 
Target Size fi elds. Adjust how the 
image will fi t into the Target Size 
by selecting a Scaling Mode. If 
you want the image to conform 
to a specifi c size, without 
stretching the image, check the 
Enable Padding box and select a 
Pad Color.

MediaPro cannot interpolate, 
or increase, the size of images. 
Thus, when you give dimensions 
larger than the image’s original 
size, this dialog will show blank 
space (or padded space) around 
the image.

The original resolution 
of images is not affected by 
resizing with MediaPro.

Scaling Mode defi nes the 
way the image with fi t into the 
Target Size.  Options include:

Scale to Fit proportionally 
scales image to the Target Size.

Pin Larger scales the image 
with its larger side expanded or 
shrunk to fi t the Target Size.

Pin Smaller scales the image 
with its smaller side expanded 
to fi t the Target Size. This option 
will fi ll the entire area, but your 
image may be clipped.

Fit Width scales image based 
on the horizontal parameters of 
the Target Size. If you apply this 
to a vertical image, some of it 
may be clipped.

Fit Height scales image based 
on the vertical parameters of 
the Target Size. If you apply this 
to a horizontal image, some of 
it may not be visible.

In this example, the image output will be clipped at the top and bottom because 
the Target Size proportions are not as tall as the dimensions of the original image.
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Rotate 
The Rotate tool is used to adjust 
the angle of an image.  You can 
adjust the rotation in increments 
as small as 1/10th of a degree. 

To rotate an image 90 
degrees clockwise, just type 90 
into the Angle fi eld. To rotate 
counter clockwise, place a 
negative sign (-) in front of the 
number in the Angle fi eld.

This rotation method is 
not the same as lossless JPEG 
rotation.  See JPEG Rotate in 
the Action menu, for lossless 
rotations of 90, -90 and 180 
degrees.

Adjust Angle: Use the arrows to rotate by increments of .1 degrees (up rotates 
clockwise; down rotates counter clockwise); or use type in the number of degrees 
to rotate (negative numbers rotate counter clockwise).

Pad Color: Select a color to use for the background of images when rotated.

Remove Grain 
This fi lter will help smooth out 
grainy images by applying a 
slight blur. 

Choose between Fine, 
Medium and Coarse, depending 
on the size the grain.

Preview: Checking this box will apply the fi lter to the image in MediaPro’s Media 
View. The time it takes to render a preview of the fi lter will vary depending on the 
complexity of the fi lter and the speed of your computer’s processor. 

Real-time preview: 
This window shows 
the affects of the 
fi lter applied to 
a sample of the 
image area at 
100%. To change 
the sample area, 
click on the image 
and drag it to the 
desired location.  
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Remove Red Eye 
This fi lter helps you remove 
the “red eye” effect caused by a 
camera fl ash.  To remove red eye 
from images:

1. Zoom in on the area where 
the eyes are located. 

2. Use the selection tool to 
draw an area around the pupil of 
the eye (below).  Depending on 

the skin tone, it is safe with some 
images to draw a box around 
both eyes. Be aware of reddish 
skin tone, lips and red hair that 
might be affected. 

3. Adjust the level of red-
eye using the Reduction slider. 
Usually somewhere in the 
middle (5 or 6) works best.

4. Click OK. Repeat steps 1-3 
to adjust the other eye.

Zoom: Use this 
slider to zoom 
in on the eyes.

Selection tool: Click 
and drag the red 
corners to adjust the 
size of the selection.

To move the image in the 
preview window, place 
your cursor in the active 
window, then click and 
drag the hand ( ). 

Area in preview window

Sharpen Edges 
This fi lter adjusts the sharpness 
of your images. It works by 
determing the edges of 
elements in the image through 
their contrast.

The Sharpening slider defi nes 
the number of pixels (from 1-10) 
in the edge neighborhood that 
are retouched.

The Edge Detection slider 
adjust how strong the contrast 
of edges must be before a pixel 
is considered to be in-range to 
be sharpened.

Be careful not to over-
sharpen the image as it will 
bring out imperfections, making 
JPEG artifacts more visible.
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Convert to Duotone 
This fi lter converts color and 
black & white images into 
duotones. Duotones were 
designed to increase the tonal 
range of a grayscale image 
by using different colors to 
reproduce different gray levels. 

To create a duotone, select a 
light and dark color by clicking 
on the respective color button. 
Then adjust the brightness 
and contrast using the sliders. 
Negative numbers reduce 
brightness and contrast.

Invert Photo 
Negative 
The Invert Photo Negative fi lter 
inverts the colors of an image. 
This fi lter is useful for turning a 
positive image into a negative 
or to make a positive from a 
scanned negative. 

Adjust Saturation 
This fi lter adjusts the color 
saturation and lightness of your 
images. 

The Saturation slider defi nes 
the intensity of a color. The 
existing level of colors in an 
image is 100. To reduce color 
saturation, drag the slider to 
a number less than 100. Zero 
represents no color, making an 
image black and white.

This tool can help 
compensate for a lack of color 
defi nition, but bear in mind that 
inkjet printers tend to over-
saturate color, rendering the 
colors unrealistic.
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Adjust Brightness 
and Contrast 
This fi lter adjusts the tonal 
range of your images though  
brightness and contrast. It can 
help to correct blurry images 
and bring out fi ne details in 
tone. 

Dragging sliders to the 
left decreases brightness and 
contrast, dragging them to the 
right increases the levels.

Auto Enhancement 
This fi lter is a one-click 
enhancement that combines 
several fi lters (including 
saturation, brightness, contrast) 
to automatically produce an 
optimal image. 

Results will vary depending 
on the tonal range of the 
original image.

Preset Enhancement 
This fi lter offers several one-click 
enhancements for your images. 

Backlight compensates for 
the effect of the subject being 
slightly backlit. Under and Over 
Exposure adjusts the tonal range 
to compensate for the effect of 
an image being under or over 
exposed.

Color Cast, Remove Bias: Images 
usually suffer from color casting 
if they have been shot using the 
wrong fi lm type. For example, 
images shot under artifi cial light 
tend to have a yellow bias. This 
fi lter removes the yellowness 
of the image. It’s also good for 
images from digital cameras 
because they have a tendency to 
be warm.

The Color Cast fi lter can be combined 
with another enhancement fi lter at 
the same time.
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Version Control 
This feature is useful both for individuals and 
small workgroups to browse and track through 
different versions of the same fi les. This is use-
ful as a backup but also to revert to or compare 
between different versions, and can be of great 
help during image editing. 

To activate this feature, select a folder using the 
Setup dialog in the Image Editor palette. Backup 
copies of version-controlled fi les will be saved 
in this folder. You must make sure that you use a 
separate folder for each catalog.  

The Version Control folder maintains a log of the 
items added and removed from the folder, with 
the name of the original fi le and, the number and 
details of each version saved. MediaPro will auto-
matically purge version control fi les for entries 
that have been removed from the catalog, when 
a catalog is closed. The size of the folder will grow, 
depending on the size and number of copies of 
fi les. It is advisable to save the folder in a directory 
which has plenty of storage space. 

Once a Version Control folder has been assigned 
to the catalog, you can begin to edit and backup 
media fi les. After you have edited an image, click 
on the Save button in the Image Editor palette. In 
this dialog, check the box Save in versions folder.

MediaPro automatically assigns the current 
time and date and, saves this data in the export 
log in the Version Control folder, together with a 
MediaPro-encoded back up copy of the fi le.  

You can examine and compare any backup 
version, at any time, by simply clicking on the 
different versions in the list. 

There are two important icons next to each 
item in the backed-up versions list: 

  The arrow icon replaces the current media 
fi le with the selected backed-up version. 
This option will also give you the opportu-
nity to Swap fi les instead of replacing it. 

  The trash icon deletes the selected 
backed-up version, and removes it from 
the Versions list. 

MediaPro 2.0 adds version control support for 

image editing performed in other third-party 
applications such as Adobe Photoshop. For 
MediaPro to recognize these edits, you must 
have the Image Editor active and open the image 
fi le with the third-party editor via the Open With 
helper application menu (pg. 60).
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Version Control Setup in the Image Editor 
palette and its resulting dialog.

Click on the folder icon to locate and choose your 
Version Control backup folder.

The Save in versions folder option of the Image Editor 
Save dialog places a backup of the original version in 
the Version Control backup folder.
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The print dialog automatically defaults to match 
the active view of your catalog. iView MediaPro 
offers three printing styles to match those views:

Content List is useful for printing a table of 
contents of your catalog. This style matches the 
layout of the catalog’s list view, with icons and 
associated fi eld information of each fi le. 

This style also includes options for showing/
hiding icons and fi eld headers on the printout. 
The size of the icons in your catalog’s List View 
determines the size of the icons in the printout. 

Contact Sheet prints a table of thumbnails 
similar to your catalog’s Thumbnail View. The size 
of the thumbnail in your catalog determines the 
size of the thumbnail in the printout.

Remember, thumbnails are imported into the 
catalog by using the fi le’s built-in thumbnail or 
ones created by MediaPro. If your thumbnails are 
printing poorly, choose Rebuild Thumbnails in the 

Action menu.  
You can also choose the Hi-Res Thumbnail 

option for quality printing.  Checking this option 
will send more image detail for every thumbnail 
to the printer, so allow extra time for printing. The 
printing speed is dependent on your computer’s 
power and the type of printer. 

Media Sheet renders the full size, hi-resolution 
images from original fi les. Since some of these 
fi les may be quite large, allow extra time for print-
ing.  The size of the displayed and printed media 
can be changed by using the Scaling pull-down 
menu (see explanation next page). 

The most useful of these is Scale to Fit, as it auto-
matically rescales the image to fi t within the print 
area. Other useful options are Actual Size, Fit Width, 
but they may hide parts of the image, when the 
size and shape of the original image is larger than 
the rendered area or printed cell size.

Printing
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Defi ne 
print area

Print view 
fi elds will 
include fi elds 
visible in 
Thumbnail 
View. Range

MediaPro’s 
print dialog box 
features a real-
time preview 
of your prints. 
Each change in 
preference will 
be rendered in 
this window. 

Margins: The 
light blue color 
represents 
margins defi ned, 
using the button 
in the upper left.

Print style

Print dialog: Contact Sheet mode

Header

Open printer 
setup dialog

Footer

By default, 
MediaPro 
prints lo-res 
thumbnails. 
Check this 
box to print 
high-quality 
images.
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Modify which 
page appears 
in the preview 
window on 
the right. 

Print view 
fi elds will 
include fi elds 
visible in 
Media View. 

Repeat media: This option will tile a single image in the available print area. 
Use the Grid option to defi ne the number and size of the tiled images. Check 
the Margin between box to place a small amount of space between tiled images. 
See an example on page 75.

Media Sheet 
prints are 
rendered from 
the original, 
hi-resolution 
images. Since 
some of these 
fi les may be 
quite large, 
allow extra time 
for printing.  

Print style

Print dialog: Media Sheet mode

Defi ne 
print area

If checked, 
the print will 
show icons 
matching the 
size chosen 
in List View 
(small or 
large).

Range options include: Defi ne in Print Box, Current Page, Odd pages 
and Even pages.  The default is set to allow your printer’s dialog box 
handle this function. 

Label row

Print style

Print dialog: Content List mode

Headers and 
footers settings 
are retained 
across all print 
styles.

Use view 
colors mimics 
the style 
set  in Media 
View. 

Use view colors 
mimics the style 
set in List View. 
In this example, 
it only shows 
the divider lines. 
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Print Options: Margins
Visible in all views.

Use Mirror margins 
for including spines on 
documents that will be 
bound or punch-holed.

Print Options:  Headers & Footers
Place labels such as headers, footers, right and left captions on your print out.

You many use one or all of 
these label fi elds on a given 
print out. This example will 
print “Favorite Photos” at the 
top of pages. On the bottom, 
it will print the Page Number 
and Total Number of Pages. 
It is acceptable to mix these 
symbols with regular text.

Click this button to 
alter typographic, 
color and style 
preferences.

Special drop-down menu 
Insert the Date, Time, Page Number, Total Number of 
Pages, and Catalog Title. These are represented by their 
respective symbols in the caption’s box.  The Ampersand 
option is to help differentiate the character from the 
special character commands. The Indent option aligns the 
label center or right. One Indent mark will center the type. 
Two Indent marks fl ushes the type right. 

Print Options: Grid
Only visible in the Thumbnail and Media Views. Cells allows the user to 

defi ne the number of 
rows and columns, but 
may override the image 
size settings or possibly 
crop some of the fi eld 
text if the Print Area 
Size is too small.

Default for view takes into 
account the predefi ned 
layout and image size 
settings selected within each 
view mode, and the Print 
Area Size. 

Size is similar to cells, 
but allows the user to 
defi ned exact size of 
each cell.

Margin dimensions will 
default to those set by 
selected printer.
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Print options
Defi ne the Print Area pull-down menu has 

options for full page, as well as CD and other 
disk cases, like Zip or Jaz. If you select Full Page, 
MediaPro uses the page size defi ned in the Page 
Setup dialog. The options will differ according 
to the type of the printer chosen. You can add 
custom print area templates to this menu. For 
instructions, see page 76.

Margins allows you to further adjust the Print 
Area Size on all sides. With the Mirror Margins 
option, you can include spines for binding docu-
ments that will be bound or punch-holed.

Headers enables you to place a label on the 
top (header), bottom (footer), right and left sides 
of your print out. You can adjust the type and style 
of the labels. In the Special drop-down, add auto-
matic page numbers, date, time and more. Header 
settings are retained across all print styles.

Grid: For Contact Sheets, this option defi nes 
the number of rows and columns for a print out. 
For Media Sheets, you can defi ne how multiple 
copies of the same image, or different images, will 
be printed.  Default for view takes into account the 
image size settings for the respective view of the 
catalog. Cells allows you to defi ne the number 
of rows and columns. Size is similar to cells, but 
allows you to defi ne exact size of each cell.

Range modifi es which pages will print. The 
default is set to allow your printer’s dialog box to 
handle this function. You may also choose Current 
Page, and Odd or Even pages. 

Printing Tips
• To print a selection of fi les, make your selec-
tion, then choose Show Selected from the Find 
menu. Print your results.

• Multi-layer/-page fi les: MediaPro only prints 
the frame assigned as an item’s thumbnail. In 
order to print a layer or page within a com-
posite fi le, go to the page or layer you wish 
print in Media View, then select Rebuild Pre-
view from the Action menu before printing.

Print dialog: Media Sheet mode (show with 2x2 grid)

Scaling menu:  Only visible in Media Sheet mode.
To defi ne the image size, choose one of the following 
options from the menu: 

Actual Size uses the 100% size of the image, and 
centers it in the Print Area.

Scale to Fit proportionally scales image to the size 
of the Print Area.

Fit Width scales image based on the horizontal 
parameters of the Print Area. If you apply this to a 
vertical image, some of it may not be visible.

Fit Height scales image based on the vertical 
parameters of the Print Area. If you apply this to a 
horizontal image, some of it may not be visible.

Pin Smaller Side draws the image with its smaller 
side expanded to fi t the screen. This option will fi ll 
the entire screen, but your image may be cropped.

Pin Larger Side draws the image with its larger 
side expanded or shrunk to fi t the screen.

Tile the image (in actual size) in the window. This 
option is helpful when you are printing patterns.

Percentages allows reduction or enlargement of 
the image from 25% to 2000%.

Preview selector:  Use the up and down arrows to 
modify which page appears in the preview window on 
the right side of the dialog box. 

Prin
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Print Templates
iView MediaPro lets you create printing templates 
to suit all your needs. These printing templates are 
text fi les and placed in the user defi ned Plug-ins 
- Print Templates folder (see Page 2 for location of 
this folder).

Printing templates allow the user to defi ne the 
specifi c size and position of the printing area on 
a page. It is made up of a line of text containing 
fi ve values separated by a single space.

Example:  -1 -1 342 339 px
• Value 1: Left margin
• Value 2: Top margin
• Value 3: Width
• Value 4: Height
• Value 5: Unit of measure

Acceptable units of measure
• in (inch)
• px (pixel)
• cm (centimeter)
• mm (millimeter) 
• Use “.” or “,” as decimal separators.

If the margin is set at “-1”, MediaPro automatical-
ly centers the printing area with these margins.

Example template for CD jewel case
The print area on the front of a standard CD jewel 
case is 120x120 mm. 

To center the image horizontally, you need 
to place it: (210-120) ÷ 2 = 45 mm on the right 
margin. 

To center the image vertically, you need to 
place it: (297-120) ÷ 2 = 88.5 mm on the left mar-
gin. For simplicity, we will use 80 mm.

The coordinates that we need for the CD case 
template are:  

45 80 120 120 mm or -1 -1 120 120 mm
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Step 4: Modify the scale, crop marks, etc. 

Step 3: Select the new template in the Print Dialog box. 

Step 2: Select the image you want to print in Media View. 
Press CMD-P or click on the printer icon in the toolbar.

Create a template
Step 1: Create a text fi le with the proper order and 
number of values. Place it in the user-defi ned Plug-ins 
- Print Templates folder (see Page 2 for location).
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PDF Maker
New in 2.0: This new feature allows you to pro-
duce high-resolution PDF fi les of any size and 
layout using the media in your catalog. It can be 
completely customized.

How to use PDF Maker
1. Launch this feature by selecting Show PDF 

Maker in the Window menu (CMD-U).
2. Start in the Layout tool by to defi ne page size 

and orientation. To show the Layout tool, click 
the large button in the upper right corner of 
the palette. Once you have this view showing, 
you can decide how and where media items 
should appear on the page. Use the various 
option tools to defi ne page size, orientation 
and unit of measure. Then use the layout 
tools to draw and move around boxes that 
will contain your media. Media locations are 
freeform and can even be overlapping.  You 
can save various layouts for later recall by 
using the Options Sets drop-down menu.

3. Once your layout is defi ned, change to the 
Content tool by clicking the large icon in the 
upper right corner of the palette. Then, simply 
drag-and-drop media from your catalog to 
the PDF layout locations. When images are 
dropped into locations, they may need to be 
resized, rotated or relocated with the media 
location box. You can use the Clear tool to 
remove an image from a box. 

4. Finally, click Make and your custom PDF fi le 
will be generated and saved to a location of 
your choice on the desktop. The time to cre-
ate PDFs, depends on the resolution of the 
images used in PDF.   

The high-resolution PDFs that you create 
are ideal for printing, but may be too large for 
distribution on the internet. Currently, there are 
no options for customizing the compression of 
images in the PDF.

Exported PDFs can be further customized using 
PDF editor application such as Adobe Acrobat.
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Click this button to toggle between Layout and 
Content panels of PDF Maker

PDF Maker palette: Layout panel

Move tool
Position or 
resize frames

Clone tool
Click on frame
to duplicate

Create tool
Click in page to 
add new frame

Delete tool
Click on frame
to remove

Set page size 
(offers 11 
standard sizes) 

Set display 
units (inches, 
centimeters)

Set page 
orientation 
(portrait, 
landscape)

Option sets
Save or load
presets

Options

Layout Tools

Click this 
button to 
save PDF to 
a location on 
the desktop.

X/Y coordinates
of page position

PDF page 
dimensions

Frame 
dimensions
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Printing to PDF
OS X users can print MediaPro catalogs to PDF 
format using the system’s built-in printing func-
tionality.  Instead of actually printing a document, 
you use the Print dialog to export your catalog 
to a PDF. 

First, use the MediaPro print dialog to custom-
ize the print style (e.g. Content List, Contact Sheet 
or Media Sheet), then click the Print button. 

In the system print dialog that appears, click   
Save As PDF. Type a name for the document and 
choose where you want to save the PDF. 
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PDF Maker palette: Content panel

Click this button to toggle between Layout 
and Content panels of PDF Maker

Drag tool
Position 
content in 
frame

Rotate tool
Set content 
orientation 
(rotates 
clockwise)

Zoom tool
Use to scale 
content in 
frame

Clear tool
Remove 
content from 
frame

Content Tools

Placing images into PDF Maker layouts

Step 1: Select and 
image in the catalog 
and drag-and-drop it 
into the desired  frame 
of the PDF. If you drop 
it into the wrong frame, 
use the Clear tool to 
remove the image from 
the frame.

Step 2: Images will 
initially appear large 
in the frame. Use the 
Zoom tool to resize 
the image. Place the 
tool cursor on the 
image and drag up to 
enlarge or drag down 
to reduce. 

Step 3: Use the Drag 
tool to position the 
image within the frame. 
Place the tool cursor on 
the image and drag it 
around in the frame to 
the desired position.

Step 4: Use the Rotate 
tool to adjust the 
orientation of the 
image within the frame. 
Place the tool cursor 
on the image and click. 
Each click represents 
a rotation 90 degrees 
clockwise.

Save As PDF:  In OS X’s print dialogs, 
there is a button that enables you to 
save your printout as a PDF instead of 
actually printing the fi le.



Appendices   79

Appendix A: Keyboard shortcuts

Application Menu

Preferences c , (Comma)

Hide iView MediaPro c H

Hide Others o c H

Quit c Q

File Menu

New Catalog c N

Close Catalog c W

Open Catalog c O

Catalog Finder s c O

Save Catalog c S

Save As... s c S

Catalog Info c K

Import Options s c I

Import from Files/Folders c I

Import from Camera o c I

Import from URL o c U

Cancel Running Tasks c .

Print c P

Page Setup s c P

Edit Menu

Undo c Z

Cut c X

Copy c C

Paste c V

Select All c A

Deselect All c D

Defi ne User Fields s c D

Window Menu

Minimize Window c M

Hide Tabs & Toolbar c T

Switch Views 
(List, Thumbnail, Media)

c 1, c 2, 
c 3

Show/Hide Panels
(Info, Organize, Folders)

c 4, c 5, 
c 6

Show View Options c J

Show Image Editor c Y

Show PDF Maker c U

Action Menu

Rebuild Thumbnail c B

Synchronize o c B

Add to Set s c M

Move to Trash c l

Find Menu

Show All c E

Show Hidden o c E

Show Selected s c E

Hide Selected Ctl c E

Find c F

Find Next c G

Sort Again o c ;

Invert Sort Order c ;

View Menu

Actual Size c 0

Rotate 90º CW c ]

Rotate 90º CCW c [

Go to Next Label c  w

Go to Previous Label c  u

Move to Location c L

Move Again s c ;

Make Menu

Run Slide Show c R

Slide Show Options s c R

Other shortcuts
• Contextual Menu

Ctrl + Click

• Start/Stop Playback
Spacebar

• Assign Color Label
1, 2, 3, 4 ...

• Remove Color Label
0 (Zero)

Useful tips
• To fi nd a fi le, type the 

fi rst letters of its name.

• To rearrange items, 
drag them to where 
you want them and 
drop them. You can 
drag single items or 
groups of items.

• To move or duplicate 
items to another 
catalog,  drag them 
from one catalog to 
the other.

• To move items from the 
catalog to the desktop, 
drag them to a folder 
or to the desktop. This 
will move the fi le from 
its current location to 
the desktop.

• To copy fi les from the 
catalog to the desktop, 
hold the Option key 
while dragging them 
to the desktop.

• To invert the order of 
media any catalog 
view, click the invert 
button (  ) in the 
upper left corner of the 
media viewing area. 

Legend  

c Command    

s Shift     

o Option

l Enter

wu Arrows

A
p
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Slide Shows

Keyboard

Escape (ESC) Exit slide show.

l (Enter or Return) Show/Hide slide show controller.
If the controller is hidden, the mouse cursor is also hidden.

Right or Down Arrow Display the next media fi le.
The next media fi le is always displayed even if show is set to random.

Option + Right/Down Arrow Move to next frame of a movie.
Suitable for stepping through movie frames while slide show is paused.

Left or Up Arrow Display the previous media fi le. The previous media fi le is always displayed even if show is 
set to random. Use the Shift key to jump to the last frame of the movie.

Option + Left/Up Arrow Move to previous frame. Suitable for stepping through movie frames while slide show is 
paused. Use the Shift key to jump to the fi rst frame of the movie.

Space Bar Run/Pause slide show.

I or i Toggle slide show interactive mode. If slide show is in interactive mode, you can move the 
next or previous items using the arrow keys or clicking the mouse.

+ or = (Plus key) Zoom in to the next available size option.

- or _  (Dash key) Zoom out to the previous available size option.

d Change display to the next available grid option.

Shift + D Change display to the previous available grid option.

L or l  (case insensitive) Set slide show to continuous (Loop) mode.

R or r (case insensitive) Set slide show to random mode.
Random mode uses all available media items once before repeating media.

M or m (case insensitive) Set slide show to multi-sound mode.
This is useful when playing multiple movies at once. When multi-sound is off you will only 
hear audio from active movie.

Tab Change the active media item to the next item in the grid. This is useful in multi-grid mode 
only. It will reset the slide show audio and swap information displayed in the info panel. 
Changing the active item also changes the order at which items are loaded.

1-9 Label active media item. 
Use the controller to check/show/hide labelled items.

0 (Zero) Remove label from active media item.

Mouse

Click (Normal mode) Run/Pause slide show.

Click (Interactive mode) Load next slide.

Shift + Click
(Interactive mode)

Load previous slide.

Option + Click Drag media in grid cell. 
This takes effect only if the displayed media is clipped, (i.e. larger than the grid cell size).

Double Click Exit slide show.

Shortcuts cont.
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Appendix B: Supported fi le formats

File Format Extension Importer

Adobe Photoshop 8BPS, ALS, PSD QT

BMP BMP, BMPf, BMPp, DIB QT

FlashPix Image FPX, FPix QT

JPEG 2000 JP2, .jp2 QT

JPEG JPEG, .JPG, .JPE QT

MacPaint MAC, MSK, PNTG, IFF QT

Picture PCT, PIC, PICT QT

PNG PNG, PNGf QT

QuickTime Image QIF, QTI, QTIF, qtif QT

SGI SGI QT

TGA TGA, TPIC QT

TIFF TIF, TIFF QT

JacqCAD Expn QT

EXIF/JPEG EXIF QT

FAX/TIFF FAX QT

GE Medical CRI CRI QT

Olympus RAW ORF iView

Minolta RAW (Preview) MRW iView

Fuji RAW (Preview) RAF iView

Canon RAW (Preview) CRW iView

Kodak PhotoCD kpcd, PCDI, PCD iView

Kodak RAW DCS DCR iView

Seattle Filmworks SFWI, SFW iView

Photo Mechanic
AP Viewer

DCBa iView

Picture Clipping clpp iView

Startup Screen SCRN iView

Canvas drw8,7, 6, 5, CNV iView

Fractal Design Painter RIFF iView

Live Picture FIT2 iView

AppleWorks CWPT iView

Genuine Fractals 8BIN, STN, STNG iView

Macintosh Icon ICN, ICNS, Icon iView

Image File Formats (Import)

Export: SGI, Adobe Photoshop, BMP, JPEG, JPEG 2000, 
MacPaint, PICT, PNG, QuickTime Image, TGA, TIFF

File Format Extension Importer

3GPP Movie 3GP, 3gpp, SDV, sdv

Animated GIF GIF, GIFf QT

AVI AVI, VFW, VfW QT

AutoDesk Animator CEL, FLC, FLI QT

DV DIF, DV, dvc! QT

Electric Image Movie 
Importer

EIDI, EIM QT

Macromedia Flash SWF, SWFL QT

MPEG MPG, MPEG QT

MPEG-4 MP4, mpeg4 QT

QuickTime Movie MOV, MooV QT

Standard MIDI KAR QT

AV/Animation File Formats (Import)

File Format Extension Importer

AIFF AIF, AIFF QT

AIFC AIFC QT

AMF Movie Importer M4A, M4B, M4P QT

AMR AMR, amr QT

Compact Disc Audio
(AIFF)

CDDA, cdda QT

GSM Audio GSM QT

MP3 MP3, MPG3, Mp3, 
PLAY, SWA, Swat, AAC

QT

Standard MIDI MID, Midi, SMF QT

Sound Designer II SD2, Sd2f QT

System Sound sfi l QT

µLaw AU, SND, ULAW, ULW QT

Wave BWF, WAV, WAVE QT

Audio File Formats (Import)

Export: AIFF, µLaw, Wave, System 7 Sound

Export: FLC, QuickTime Movie, AVI, DV Stream, Image 
Sequence, MPEG-4

Note: MediaPro’s capacity to import certain 
fi le types is dependent on having the most 
current version of QuickTime installed in 
your operating system. iView recommends 
installing the latest version, 6.x.
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File Format Extension Importer

PDF PDF QT

MultiAd Creator Crtr, CRTR iView

Adobe InDesign InDd iView

Adobe PageMaker ALB6, AB65 iView

DTP File Formats (Import)

File Format Extension Importer

Adobe Illustrator AI iView

AppleWorks CWGR iView

Canvas drwx, drw9, drw8, 
drw7, drw6, drw5, 
CNV, CVX

iView

CorelDRAW CDR5, CDR6, CDR7, 
CDR8, CDR9, CDRA, 
CDR

iView

Macromedia Freehand FHD3, AGD1, AGD2, 
AGD3, AGD4, FH5, 
FH6,  FH7,  FH8,  FH9, 
FHX, FH11, 

iView

Postscript EPSF, EPSP, EPS Ghost-
script

PowerCADD Pd%4 iView

Illustration File Formats (Import)

File Format Extension Importer

Text TEXT, TXT, ttro iView

AppleWorks CWWP iView

Text Clipping clpt iView

Text File Formats (Import)

File Format Extension Importer

Font FFIL, ffi l, tfi l, DFNT, 
TTF, TTC, SFNT, OTF

iView

HTML Document HTML, HTM iView

Other File Formats (Import)

Cataloging unsupported formats
iView MediaPro allows you to add basic catalog-
ing support for other media fi le types by modi-
fying the Custom importer list. Thumbnail and 
media rendering of these fi les is not supported. 
Instead, these fi les will be represented by a gener-
ic icon corresponding to the fi le type group.

To add a fi le type to the Custom importer list:
1. Locate MediaPro’s Documentation - Examples 

Importers folder.
2. Open the Custom fi le with any text editor.
3. Add your own types at the bottom of the fi le.
4. For example, to add FileMaker fi les, type

FMP3|6|FileMaker Pro
The fi rst four characters are the fi le type. The 
next is the Media ID, which are listed at the 
top of the list. If you choose the wrong ID, 
MediaPro will not catalog the fi le. The remain-
ing segment is the name of the program.  You 
must follow the exact format in order for the 
new fi le importer to work properly.

5. Save the text fi le.
6. Put the Custom fi le into the user-defi ned Plug-

ins - Importers folder (see Page 2 for location).

Finding fi le types: The most complicated part 
of adding a custom importer is identifying the 
appropriate fi le type. 

In OS 9.x, launch Sherlock (CMD-F) in the Finder. 
With the More Search Options dialog box open 
(CMD-M), drag-and-drop any fi le from the Finder to 
the More Search Options window. The fi le’s criteria 
appear in relevant boxes, including fi le type.

In OS X, there is no utility in the operating sys-
tem that can identify fi le types. However, there is 
a shareware utility that can assist you, XRay.  Drag-
and-drop the fi le on the to the XRay window as 
directed by the application. Under the Show pull-
down menu, select Type, Creator and Extension. 
This will display the fi le type information.

Video DTP Image

Supported fi le formats cont.

Note: MediaPro can only export image, video and audio 
fi le formats. Illustration, desktop publishing, text, font 
and HTML formats cannot be exported.
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Basic troubleshooting
Make sure that you have the installed:

1. The latest version of MediaPro from our site. 
http://www.iview-multimedia.com/

2. The latest version of QuickTime from Apple’s 
site. We highly recommend downloading and 
using QuickTime 6.x.
http://www.apple.com/quicktime/

3. CarbonLib system extension 1.5 or higher 
(OS 9 only) 1.6 is recommended.

You can also solve problems by:
1. Deleting the MediaPro preferences in the 
System’s Preferences folder.

2. Turning off non-Apple or non-Carbon com-
patible extensions (OS 9 only). 

Thumbnails look fuzzy, pixelated.
By default, MediaPro imports thumbnails that have 
been embedded into the fi le by other programs 
(such Internet Explorer or Photoshop) or devices 
(digital cameras). This makes MediaPro very fast 
when importing media, but embedded thumb-
nails may sometimes look blurry or pixelated. To 
improve the quality of the thumbnail, chose the 
image(s) and select Rebuild Thumbnail from the 
Action menu. Another option is to select Ignore 
Built-in Thumbnails in the Import Option dialog 
under the Edit menu. This option tells MediaPro 
to build its own high-quality thumbnail for each 
image (See page 17 for more information).

I have Mac OS 9.x, how much memory should 
I allocate to iView MediaPro?
The default (8MB) is 99% of the time adequate, 
unless you want to open more than 10 catalogs 
at once, or you want to create huge movie presen-
tations. MediaPro doesn’t need more memory, as 
all rendering is performed using QuickTime and 
System memory. In fact, it’s counter-productive to 
increase MediaPro’s memory partition because it 
takes away from System memory.

Viewing Nikon NEF digital camera raw fi les 
is one of the exceptions to this rule. Increase 
you memory allocation to 15 MB or higher to 
improved performance in MediaPro.

Transition effects do not appear to work in 
slide shows exported as a QuickTime movie.
If you are using video compression, make sure 
that your frame rate is higher than 1 fps (frame 
per second). If there is no value in the QuickTime 
compression settings dialog box, fps defaults to 
1, and you’ll get no effect (as the effect lasts for 
only one second).

Common Error Messages
No importer found: This error message appears 
when MediaPro cannot display or render a par-
ticular fi le type. Try upgrading to the latest version 
of QuickTime. 

Volume not mounted: iView Media needs access 
to the actual fi le in order to display it on the screen 
in Media View or Slide Shows. This error is displayed 
when MediaPro cannot fi nd the media storage 
device or disk on which the fi le is stored. Mount-
ing the disk should solve the problem. 

Customer Support
If you have additional questions, please make 
sure you check the manual, our online FAQ and 
community forum. If you still can’t fi nd an answer, 
or you would like to send us a comment or sug-
gestion, then fi ll out our online technical support 
form at:
www.iview-multimedia.com/support/directsupport.html

Customer forums
Join the community of iView users.  Find answers 
to many issues, learn about new features, and 
post questions. Connect online at:
http://www.iview-multimedia.com/

Appendix C: Troubleshooting
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It is important that you carefully read this notice before proceeding with the download, 
installation and use of the software. By clicking the button below marked “continue” you 
agree to be bound by the terms of this agreement which constitutes a legally bind-
ing contract between the licensor, (hereafter “iView multimedia ltd”), and the licensee, 
(hereafter “you”).

1 THIS AGREEMENT
1.1 In this Agreement the phrase the Software means the computer program above 
and all associated media, printed materials, “online” or electronic documentation and 
bundled software. This defi nition of “the Software” does not include any other products 
or computer programs of iView Multimedia Ltd.
1.2 The Software is protected by copyright and other intellectual property laws and 
international treaties. Title to, ownership of, and all rights and interests in and to each 
and every part of the Software, (including all copyrights, trade marks, patent rights or any 
other intellectual property rights of whatever nature), and all copies thereof shall remain 
at all times vested in iView Multimedia Ltd or its licensors.
1.3 The Software is licensed, not sold, to You for use only under the terms of this licence 
agreement, and iView Multimedia Ltd and its licensors reserve any rights not expressly 
granted to You. Your rights of ownership are limited to the media on which the Software 
is recorded or fi xed.
1.4 By installing, copying or otherwise using the Software, you agree to be bound by the 
terms of this Agreement. If You do not agree to the terms of this agreement You must 
not use the Software and must immediately delete any and all copies of the Software 
in Your possession. 
2 GRANT OF LICENSE
2.1 iView Multimedia Ltd hereby grants to You the following non-exclusive rights in 
respect of the Software subject to Your fulfi lment of the relevant criteria. The rights 
granted to You are personal and non-transferrable.
2.2 Evaluation License. You may use a copy of the evaluation version of the Software, 
(comprising the evaluation version of the program and any accompanying documenta-
tion), for evaluation purposes only without charge for a period of 21 days. If You continue 
to use the Software after expiry of the evaluation period You must pay the License fee 
and obtain a full License. Until You have paid the License fee for the Software, You may 
only use the Software for evaluation purposes. For details of payment, please refer to the 
Purchase Information in the package or visit our website at:www.iview-multimedia.com. 
When payment has been received by iView Multimedia Ltd You will be sent a License 
number which will unlock any locked or disabled functionality in the evaluation version 
of the Software
2.3 Single User License. You may use the Software on a single computer for your personal, 
educational or business use PROVIDED THAT you have obtained from iView Multimedia 
Ltd a Single User License Number. Under this Single User License you may also install the 
Software on a second computer, for example a home computer or laptop, provided that 
you are the sole user of both computers and that you do not allow concurrent use of the 
Software by more than one individual.
2.4 Multi User License Packs or Volume Site Licenses. You may use the Software on a 
computer network and/or allow concurrent use of the Software by more than one 
individual for personal or business use PROVIDED THAT You have obtained from iView 
Multimedia Ltd a Multi User License Pack or signed the Volume License Agreement which 
supplements this Agreement for the issue of single Site License Number(s). The maximum 
permissible number of concurrent users shall be specifi ed by iView Multimedia Ltd in 
the License Pack or in the Supplement Volume License Agreement at the time of issue 
of the License Number(s).
3 YOUR OTHER RIGHTS AND OBLIGATIONS
3.1 You may distribute copies of the original archive of the evaluation version of the 
Software (which is locked) on any CD, Web Site, FTP Site, or other “download area” without 
permission from iView Multimedia Ltd PROVIDED THAT You do not charge or request 
donations for any such distributed archives of the evaluation version of the Software. 
You are prohibited from distributing any other versions of the Software without the prior 
written permission of iView Multimedia Ltd.
3.2 Your copy of the Software may include iView Multimedia Ltd’s freeware program, 
iView Catalog Reader. This is offered to You by iView Multimedia Ltd as freeware and 
may be copied, distributed royalty free on any CD, Web Site, FTP Site, or other “download 
area” without permission from iView Multimedia Ltd and used without any restriction 
PROVIDED THAT You do not charge or request donations for any such distributed archives 
of the software. All defi nitions are as defi ned in this agreement. 
3.3 Save as expressly set out in this Agreement You may not copy, reproduce, publish, 
rent out, lease, modify, create derivative works from the Software nor may You remove 
any proprietary notice, labels, or marks on the Software. Unless permitted by law, You 
may not modify, adapt, reverse engineer, decompile, disassemble, create derivative works 
based on, or copy the Software.
3.4 You undertake not to export the Software or any part thereof to any country, person, 
entity or end user subject to any export restrictions applicable to You.
4 RESERVATION OF RIGHTS
4.1 To the fullest extent permitted by applicable law, iView Multimedia Ltd and its licen-
sors disclaim all other warranties and conditions in respect of the software either express 
or implied, including but not limited to any implied warranties of merchantability, non-

infringement of third party rights and fi tness for particular purpose. The duration of any 
statutorily required warranty period shall be limited to the term of the limited warranty.
5 INTELLECTUAL PROPERTY RIGHTS
5.1 The Software is protected by copyright and other intellectual property laws and 
international treaties. Title to, ownership of, and all rights and interests in and to each 
and every part of the Software, (including all copyrights, trade marks, patent rights or any 
other intellectual property rights of whatever nature), and all copies thereof shall remain 
at all times vested in iView Multimedia Ltd.
6 LIMITED WARRANTY
6.1 iView Multimedia Ltd warrants that the medium on which the Software is supplied, if 
any, shall if manufactured by or on behalf of iView Multimedia Ltd be generally free from 
errors of workmanship for a period of 30 days from purchase.
6.2 The Software is provided “as is” without warranty of any kind either express or implied. 
In particular iView Multimedia Ltd does not warrant that the operation of the Software 
will be uninterrupted or error free. iView Multimedia Ltd does not warrant guarantee or 
make any representations regarding the use, or the results of the use, of the Software in 
terms of accuracy reliability currentness or otherwise. You assume the entire risk arising 
out of the use or performance of the Software.
6.3 No oral or written information or advice given by iView Multimedia Ltd its distributors 
or employees shall create any warranty and You may not rely on any such information 
or advice.
7 NO OTHER WARRANTIES
7.1 To the fullest extent permitted by applicable law, iView Multimedia Ltd disclaims all 
other warranties and conditions in respect of the software either express or implied, 
including but not limited to any implied warranties of merchantability, non-infringement 
of third party rights and fi tness for particular purpose. The duration of any statutorily 
required warranty period shall be limited to the term of the limited warranty set out 
above. You use the software entirely at your own risk.
8 EXCLUSION OF LIABILITY FOR CONSEQUENTIAL LOSS
8.1 Under no circumstances shall iView Multimedia Ltd or anyone else who has been 
involved in the creation, production, or delivery of the software be liable for any conse-
quential or incidental damages whatsoever arising out of your use of or your inability 
to use the software, including without limitation, damages for loss of business profi ts, 
business interruption, loss of business information, computer failure, work stoppage or 
any other damages, even if iView Multimedia Ltd has been advised of the possibility 
of such damages.
9 EXCLUSIVE REMEDY
9.1 The exclusive remedy for breach of this Agreement by iView Multimedia Ltd shall be, 
at iView Multimedia Ltd’s option, either:
9.1.1 the repair or replacement of the Software PROVIDED THAT the Software is returned 
to iView Multimedia Ltd with proof of License; or
9.1.2 a refund of the price, if any, which You paid to license the Software.
10 LIMITATION ON LIABILITY
10.1 iView Multimedia Ltd’s liability to you in contract or tort shall in no event exceed the 
actual price paid for the software or £5 (fi ve pounds sterling) whichever is the greater.
11 TERMINATION
11.1 In the event that You fail to comply strictly with the terms and conditions of this 
Agreement, this Agreement shall terminate forthwith without prejudice to any other 
remedies which iView Multimedia Ltd may have.
11.2 In the event that You wish to terminate this License agreement You may do so at any 
time by ceasing to use the Software.
11.3 You hereby agree that, in the event of termination of this Agreement for any reason, 
You will forthwith destroy or irretrievably delete all copies of the Software, including 
modifi ed copies, in Your possession or control.
12 UPDATE POLICY
12.1 iView Multimedia Ltd may from time to time create updated versions of the Software 
and may, at its option, make such updates available to You.
13 GENERAL TERMS
13.1 Irrespective of the country in which the Software was acquired the construction, 
validity and performance of this Agreement shall be governed in all respects by English 
law and You agree to submit to the exclusive jurisdiction of the English courts.
13.2 If any provision of this agreement is found to be invalid by any court having compe-
tent jurisdiction, the invalidity of such provision shall not affect the validity of the remain-
ing provisions of this agreement, which shall remain in full force and effect.
13.3 No waiver of any term of this agreement shall be deemed a further or continuing 
waiver of such term or any other term.
13.4 This agreement constitutes the entire agreement between You and iView Multime-
dia Ltd with respect to this transaction. Any changes to this agreement must be made in 
writing, signed by an authorised representative of iView Multimedia Ltd.

Should You have any questions concerning this Agreement, 
or if You desire to contact iView Multimedia for any reason, please write to: 
iView Multimedia Ltd,  30-40 Elcho Street, London, SW11 4AU, U.K. 
Tel ++44 20 7223 8691; Fax: ++44 20 7223 8712 Email: info@iview-multimedia.com. 
For ordering information, visit our website at: http://www.iview-multimedia.com.

iView MediaPro End-User License Agreement, including iView Catalog Reader
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